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1. Welcome

Welcome to use the User Manual for the Mech-Vision and Mech-Viz software.

In the Mech-Mind Vision System, the vision processing, path planning, and robot control functions
are provided by Mech-Vision and Mech-Viz.

Release Notes

Mech-Vision Release Notes

New features, improvements, and resolved issues of the latest Mech-Vision version.

See more

Mech-Viz Release Notes

New features, improvements, and resolved issues of the latest Mech-Viz version.

See more

Before You Upgrade

Upgrade notes for Mech-Vision and Mech-Viz.

See more

Installation Guide

Software downloading, installation, upgrade, uninstallation, repair and modification.

See more

Project Migration Guide

Project migration required for the software upgrade.

See more

Software User Manual

Mech-Vision
Mech-Vision Machine Vision Software
See more

Mech-Viz

Mech-Viz Robot Programming Software
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See more
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2. Release Notes

This document introduces the new features, improvements, and resolved issues of version 1.8 of
Mech-Vision, Mech-Viz and the communication component.

;] Before upgrading Mech-Vision and Mech-Viz, please read this section carefully.

For the software upgrade notes and project migration guide, refer to 1.8.0 Upgrade Notes and
1.8.0 Project Migration Guide.

For the new features, improvements, and resolved issues introduced in Mech-Vision 1.8, refer to
Mech-Vision 1.8 Release Notes.

For the new features, improvements, and resolved issues introduced in Mech-Viz 1.8, refer to
Mech-Viz 1.8 Release Notes.

For the new features, improvements, and resolved issues introduced in Communication
Component Release Notes.

2.1. Before You Upgrade

1.8.0 Upgrade Notes

This section introduces the upgrade notes for Mech-Vision 1.8.0, Mech-Viz 1.8.0, and the
communication component.

When the origin of the robot reference frame was not at the bottom of the robot base, the tool
pose on the robot teach pendant would be inconsistent with the values in the software. With
version 1.8.0, this problem can be solved.

+ After you create a project using some robot models with the 1.8.0 software, the DH1 no longer

requires manual compensation when you perform manual calibration, teach the pick point, or
send the planning or recognition result in tool poses to the robot through Adapter.

+ When opening projects/solutions created with versions earlier than 1.8.0, the software will
automatically switch to compatibility mode, and you can see a “Compatibility mode”
watermark displayed on the interface. For certain robot models, the DH1 still should be

compensated manually when you perform manual calibration, teach the pick point, or send the

planning or recognition result in tool poses to the robot through Adapter. (If the DH1 has
already been compensated in projects created with earlier versions, you do not need to
compensate again.)

When you use Mech-Vision 1.8.0 in conjunction with Mech-Viz 1.8.0, please ensure the two

software is in the same mode. The software cannot function properly if their modes are different. If

this is the case, please refer to the following table to operate accordingly.

© 2024 Mech-Mind Robotics Technologies Ltd.
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Mech-Vision Regular mode Mech-Vision Compatibility mode

Mech-Viz Use as normal. According to the previous project logic

Regular mode and configuration, create a new project

in Mech-Vision and re-calibrate the
extrinsic parameters of the camera.

Mech-Viz According to the previous project logic  Use as normal.
Compatibility  and configuration, create a new project
mode in Mech-Viz.

+ When opening projects/solutions created with versions earlier than 1.8.0, the software
will automatically switch to compatibility mode. Even though you save the project in the
current software, the software will still be in compatibility mode.

+ The software will be in Regular mode when you create a new project with version 1.8.0.

Mech-Vision 1.8.0 Upgrade Notes

- After Mech-Vision is upgraded to 1.8.0, pay attention to the following notes when you use the
Production Interface.

o The production interface that you have deployed with a typical application in Mech-Vision
1.7.0 or earlier cannot be used anymore.

o The production interface that you have customized for your application in Mech-Vision
1.8.0 or earlier can still be used. However, the production interface may fail to be opened
due to the change in several files. To solve these issues, please contact Mech-Mind
Technical Support.

+ From version 1.8.0, Mech-Eye TOF cameras, MindVision 2D cameras, and SmartRay 3D laser
profilers are no longer supported in the Capture Images from Camera Step.

+ Mech-Vision 1.8.0 improved the “Sampling Interval” in the 3D Fine Matching and 3D Fine
Matching (Multiple Models) Steps. If the “Sampling Interval” set in the project created with
earlier version software is not appropriate, the project execution may be slowed down.

- Mech-Vision 1.8.0 improved the deep learning model in the Predict Pick Points (Any Objects),
so that the model optimization time is reduced during Step execution. However, when you
execute the Step for the first time after the software is installed or the IPC is changed, the time
it takes to optimize the model may be longer.

+ Mech-Vision 1.8.0 improved the picking configuration files used in the Predict Pick Points V2
Step. Projects downloaded in the solution library of Mech-Vision 1.7.4 or earlier versions and
used this Step cannot be run in Mech-Vision 1.8.0 or further versions. Please re-download the
corresponding project in the new version software.

- Mech-Vision 1.8.0 improved the Step Library. Some of the Steps were removed, and the Step
categories of some Steps were changed. See the following for details.
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Removed Step Steps moved to “Legacy”

Calc Disparity Image, Calc 2D Poses of
Rectangles, Calc Poses and Dimensions of
Rectangles, 2D Matching, Count Boxes, Deep
Learning Inference (Mech-DLK 2.1.0/2.0.0),
Defect Detection, Detect Fiducial Markers,

Detect Edges (Deep Learning), Image Remove Overlapped Objects, Remove
Classification, Generate Rectangle Overlapped Objects V2, 3D Coarse Matching,
Candidates, Instance Segmentation, Load 2D 3D Fine Matching (Multiple Models), 3D
Templates, Object Detection, Pallet Coarse Matching (Multiple Models), Adjust

Information Recognition, Validate and Calc Poses, Sort 3D Poses
Parameter Compensation, Evaluate 2D Poses,

Generate Rectangular Edge Templates of

Specified Sizes, Remove Overlapped

Polygons, Remove Polygons outside Mask,

Calc Calibration Board Poses

Mech-Viz 1.8.0 Upgrade Notes

+ The singularity detection algorithm has been improved in version 1.8.0. Once the software is
upgraded, the singularity detection result may be different from that in earlier versions.
However, the singularity detection result in the current version is more accurate.

+ The algorithm for limiting the range of motion of the robot’s shoulder, elbow, and wrist has
been improved in version 1.8.0. Once the software is upgraded, the robot path may be different
from that in earlier versions. However, the improved algorithm ensures the motion range limit
takes effect, enhancing the accuracy and stability of the robot motion.

+ The pick point calculation algorithm has been improved in version 1.8.0. Once the software is
upgraded, the robot path may be different from that in earlier versions. However, more pick
points can now be calculated and more appropriate paths can be planned.

+ The collision model of the end tool in STL format is no longer supported in version 1.8.0. If the
collision model of end tool you use is in STL format, you should convert the STL file to the OBJ
file by using the Model Editor and then configure the end tool collision model again.

Upgrade Notes on Communication Component

Changes in Communication Component Usage

- Starting from version 1.8.0, Mech-Center will only run as a background communication
component of the vision system when Mech-Vision or Mech-Viz is launched.

+ The user interface designed for Mech-Center was removed. Standard Interface
communication and Adapter communication should be configured in Mech-Vision, while
Master-Control communication should be configured in Mech-Viz.

Upgrade Notes on Adapter Project

« The Step parameters of the “Set DO” and “Check DI” Steps were modified in Mech-Viz 1.8.0.
Consequently, if these two Steps were used in the Adapter project created with an earlier
software version, the relevant Step parameters in the code should be modified as well. You can
check the key names of the Step parameters by using the Key Query Tool.

- Once the software is upgraded, if the Adapter project created with an earlier software version
inherits classes from the Standard Interface program, it requires the addition of initialization
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parameters to function properly. For details on changes of each protocol, go to Mech-
Center\Robot_Interface\Adapter_Sample_Projects\Adapter Inherits
Standard Interface inthe software installation directory.

Upgrades Notes on Standard Interface Communication with Robots

- If the Standard Interface program is not reloaded onto the robot, and no message from the
“Notify” Step is needed, i.e,, Command 6071 does not need to be triggered, the robot program
does not need to be modified.

- If the Standard Interface program is not reloaded onto the robot, and the message from the
“Notify” Step is needed, i.e.,, Command 6071 needs to be triggered, the mm_get_notify function
should be coded in the robot program manually. Please contact Mech-Mind Technical Support
for further assistance.

- If the Standard Interface program is reloaded onto the robot in the project, please modify the
robot program according to the following instructions.

o When establishing Standard Interface communication with ABB robots, MM_Open_Socket
and MM_Close_Socket should be called in the main program to establish and terminate
the connection.

o The Standard Interface programs corresponding to certain commands of FANUC, KUKA,
ABB, YASKAWA, and KAWASAKI are modified as follows:

= The “lastdata” parameter is removed from the five programs, i.e., mm_get_vizdata,
mm_get_visdata, mm_get_vispath, mm_get_plandata, and mm_get_dydata. Instead,
the programs internally loop until all vision data is received.

= The “resource” parameter is added to the mm_get_dolist and mm_get_plandata
programs to distinguish the sources of DO signal or Vision Move output, i.e., from
Mech-Vision or Mech-Viz.

= The robot program should call the mm_get_notify function to receive the message set
in the “Notify” Step in the project. The notification data cannot be received directly as
before.

Upgrades Notes on Standard Interface Communication with PLCs

- If the Standard Interface program is not re-downloaded in the project, and no message from
the “Notify” Step is needed, i.e.,, Command 6071 does not need to be triggered, the PLC program
does not need to be modified.

- If the Standard Interface program is not re-downloaded in the project, and the message from
the “Notify” Step is needed, i.e.,, Command 607 needs to be triggered, the
MM_Get_Custom_Notify function should be adjusted in the PLC program manually. Please
contact Mech-Mind Technical Support for further assistance.

- If the Standard Interface program is re-downloaded in the project, please modify the robot
program according to the following instructions.

o The PLC program should enable the MM_Get_Custom_Notify function to receive the
message set in the “Notify” Step in the project. The natification data cannot be received
directly as before.

o When establishing Standard Interface communication with Siemens PLC Snap 7, please
note that the input and output parameters have been modified.
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Upgrade Notes of Previous Versions

1.7.2 Upgrade Notes

1.7.0 Upgrade Notes

2.2. Mech-Vision Release Notes

This document introduces the new features, improvements, and resolved issues of Mech-Vision
1.8.

Mech-Vision 1.8.1 Release Notes

This document introduces the improvements, and resolved issues of Mech-Vision 1.8.1.

Improvements

Improved Camera Calibration Tool

Mech-Vision 1.8.1 improved the camera calibration tool and adjusted the standards for the
intrinsic parameter check, making the tool more suitable for actual usage scenarios.

Resolved Issues

The following issues have been resolved in Mech-Vision 1.8.1:

+ When the software language was set to Japanese, the drop-down menu of the Tool to Be Set
parameter of the Global Configuration in the Path Planning Step did not take effect.

Release Notes of Previous Versions

Mech-Vision 1.8.0 Release Notes
Mech-Vision 1.7.4 Release Notes
Mech-Vision 1.7.2 Release Notes
Mech-Vision 1.7.1 Release Notes
Mech-Vision 1.7.0 Release Notes
Mech-Vision 1.6.2 Release Notes
Mech-Vision 1.6.1 Release Notes

Mech-Vision 1.6.0 Release Notes

2.3. Mech-Viz Release Notes

This document introduces the new features, improvements, and resolved issues of Mech-Viz 1.8.
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https://docs.mech-mind.net/en/suite-software-manual/1.7.4/upgrade-notes.html#_1_7_2_upgrade_notes
https://docs.mech-mind.net/en/suite-software-manual/1.7.4/upgrade-notes.html#_1_7_0_upgrade_notes
https://docs.mech-mind.net/en/suite-software-manual/1.8.0/vision-release-notes.html#vision-release-note-180
https://docs.mech-mind.net/en/suite-software-manual/1.7.4/vision-release-notes.html#vision-release-note-174
https://docs.mech-mind.net/en/suite-software-manual/1.7.4/vision-release-notes.html#vision-release-note-172
https://docs.mech-mind.net/en/suite-software-manual/1.7.4/vision-release-notes.html#vision-release-note-171
https://docs.mech-mind.net/en/suite-software-manual/1.7.4/vision-release-notes.html#vision-release-note-170
https://docs.mech-mind.net/1.6/en-GB/SoftwareSuite/ReleaseNote/MechVision.html#mech-vision-1-6-2-release-note
https://docs.mech-mind.net/1.6/en-GB/SoftwareSuite/ReleaseNote/MechVision.html#mech-vision-1-6-1-release-notes
https://docs.mech-mind.net/1.6/en-GB/SoftwareSuite/ReleaseNote/MechVision.html#mech-vision-1-6-0-release-notes.adoc

i o/

MECH MIND Vision System Software Manual

Mech-Viz 1.8.1 Release Notes

This topic introduces the resolved issue in Mech-Viz 1.8.1.

Resolved Issues

The following issues have been resolved in Mech-Viz 1.8.1:

- When the software language was Japanese, the drop-down menu of the “Tool” parameter of
the “Change Tool” Step and “Check Tool” Step did not take effect.

Release Notes of Previous Versions

Mech-Viz 1.8.0 Release Notes
Mech-Viz 1.7.4 Release Notes
Mech-Viz 1.7.2 Release Notes
Mech-Viz 1.7.1 Release Notes
Mech-Viz 1.7.0 Release Notes
Mech-Viz 1.6.2 Release Notes
Mech-Viz 1.6.1 Release Notes

Mech-Viz 1.6.0 Release Notes

2.4. Communication Component Release Notes

This document introduces the new features, improvements, and resolved issues of version 1.8 of
the communication component.

Communication Component 1.8.1 Release Notes

No feature optimizations or issue fixes have been made in version 1.8.1 of the communication
component.

Release Notes of Previous Versions

Communication Component 1.8.0 Release Notes
Communication Component 1.7.4 Release Notes
Communication Component 1.7.2 Release Notes
Communication Component 1.7.1 Release Notes
Communication Component 1.7.0 Release Notes

Communication Component 1.6.1 Release Notes
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2.5. Project Migration Guide

1.8.0 Project Migration Guide

Migration from 1.7.X Project to 1.8.0 Project

Vision System Software Manual

Starting from version 1.8.0, Mech-Center will only run as a background communication component
of the vision system when Mech-Vision or Mech-Viz is launched. Specifically, Standard Interface
communication and Adapter communication should be configured in Mech-Vision, while Master-

Control communication should be configured in Mech-Viz.

Project Type (Divided According to the Actions after Software Upgrade

Communication Modes in Actual Use)

Standard Interface communication, Adapter Keep the same usage as 1.7.X version.

communication

Master-Control communication Reset configuration of Master-Control
communication in Mech-Viz by following these

steps:

1. Start Mech-Viz, and select the robot model that
corresponds to the real robot model.

2. Click [ Master-Control Robot ] in the toolbar.
3. After setting the IP address of robots, click

[ Connect the robot].

For more notes after the upgrade, please refer to upgrade-notes-180.pdf.

Migration from 1.6.X Project to 1.8.0 Project

It is recommended to upgrade 1.6.X project to 1.7.X project first. For more detailed description,

please refer to 1.7.0 Project Migration Guide.

Then you can upgrade 1.7.X project to 1.8.0 project. For more detailed description, please refer to

Migration from 1.7.X Project to 1.8.0 Project.

Project Migration Guide of Previous Versions

1.7.0 Project Migration Guide
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3. Installation Guide

This chapter guides you through the downloading, installation, upgrade, uninstallation, repair, and
installation modification of Mech-Vision and Mech-Viz.

Mech-Mind software has the following features: (1) Provide easy-to-use setup wizard. (2) Support
standard installation, upgrade and uninstallation procedures. (3) Support English, Simplified
Chinese, Japanese and Korean. (4) Support automatic adaptation to various resolutions.

If you are using Mech-Vision and Mech-Viz for the first time, refer to Install Software to complete
the software installation.

If you have already installed Mech-Vision and Mech-Viz, refer to Upgrade Software to upgrade the
software to the latest version.

System Requirements

Mech-Vision and Mech-Viz can be used only when being installed on the IPC (industrial personal
computer) or your PC (personal computer). The IPC or PC for installing software should meet the
following recommended system requirements:

Authorized dongle License dongle with Mech-Vision and Mech-Viz authorization
Operating system Windows 10 or above

Needs to support the AVX2 instruction set and meets any of the
following conditions:

+ IPC or PC without any discrete graphics card: Intel i5-12400 or

higher.

CPU
« IPC or PC with a discrete graphics card: Intel i7-6700 or higher,

with the graphics card not lower than GTX 1050 Ti.

IPCs with Intel CPUs are fully tested while IPCs with AMD CPUs are
not yet tested. Therefore, Intel CPUs are recommended.

Memory 8GB or above
GPU NVIDIA GTX 1050 Ti or above (if with a discrete graphics card)
Hard disk 128 GB SSD or larger

+ Mech-Vision and Mech-Viz do not support discrete graphics cards other than NAVDIA.

+ Ensure that the hard disk where software will be installed on IPC or PC should have at
o least 10 GB free space; otherwise, installation may fail.

- If the CodeMeter driver has not been installed on the IPC or PC, it will be automatically
installed to the hard disk C during software installation. Do not uninstall it or move its
installation files; otherwise, license authorization may fail and you are not allowed to use
Mech-Vision and Mech-Viz.

When using Mech-Vision and Mech-Viz, the resolution and scaling of the screen should follow
the correspondence in the table below. If the resolution and scaling of your screen do not
° match those in the table below, some display problems may occur.

If you are using dual monitors, make sure that both have the same resolution and scaling.

© 2024 Mech-Mind Robotics Technologies Ltd. 10
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Resolution Scaling
1280800 (16:10 100%
1920x1080 (16:9 100%, 125%
2560x1440 (16:9 125%, 150%

)
)
)
3840x2160 (16:9)

150%, 175%

Download Software Installation Package

Mech-Mind provides a software installation package for Mech-Vision and Mech-Viz (Mech-Vision &
Mech-Viz installer).

+ The Mech-Vision & Mech-Viz installer integrates the CodeMeter driver to adapt to the
Dongle for software license authorization.

+ The Mech-Vision & Mech-Viz installer integrates the Python 3.6.5 environment and no
longer includes the running environment check tool.

+ The Mech-Vision & Mech-Viz installer integrates the basic communication component
Mech-Center, which includes a built-in Python 3.6.8 environment.

You can download the software installation package from Mech-Mind Download Center or contact
Mech-Mind pre-sales or support engineers.

Install Software

Verify Integrity of Software Installation Package

Since the software installation package may be corrupted during transmission or downloading,
you need to verify the integrity of the software installation package. The integrity of the installation
package can be verified with the CRC-32 value, which is provided on the download page.

(i ) Please install and use the 7-Zip software to calculate the CRC-32 value.
To verify the integrity of the software installation package, follow these steps:

1. Copy the installation package to a specified directory on the IPC or PC, such as D:/.

2. Decompress the installation package. After decompression, you will obtain the installer (Mech-
Vision & Mech-Viz Installer 1.8.1) and the content folder.

(i ] After decompression, do not move the installer and the content folder.

3. Open 7-Zip, and use the address bar to navigate to the directory where the software installation
package is located.

4. Select the software installation package, and in the menu bar, select File » CRC » CRC-32 to
calculate the CRC-32 value.

5. Check the calculated CRC32 value against the one on the download page. The two values
should be identical.

6. Repeat steps 3—5 on the installer and content file after decompression.

If the calculated CRC32 values of the software installation file and the content folder do
not match those provided on the download page, please download it again.
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https://downloads.mech-mind.com/?tab=tab-front

i o/

MECH MIND Vision System Software Manual

Install Software

To install Mech-Vision and Mech-Viz, follow these steps:
1. Double-click the software installation file(EXE file) and open Mech-Vision & Mech-Viz Setup
Wizard. The Welcome window is displayed.
2. In the Welcome window, browse the software information and click [ Next].

3. Inthe License Agreement window, read the license agreement carefully, check the [ | accept
the terms and conditions in the license agreement] check box, and then click [ Next].

4. In the Select Product window, select the products(Mech-Vision x.x.x and Mech-Viz x.x.x) to
install. Select the [ Create desktop shortcut(s) ] checkbox (recommended), and then click the
[ Next] button.

o Mech-Center is forced to be installed along with the products as a fundamental
o communication component, but will not have a desktop shortcut.

o Mech-Center cannot be opened individually and can only be evoked by Mech-Vision
or Mech-Viz to provide communication in the background.

5. In the Set Path window, change the installation path as required, such as “D:/project”, and then
click the [ Next ] button.

If the installation path is not changed, the default software install paths are as follows
during the initial installation:

o ° Mech-Vision:C: /Mech-Mind/Mech-Vision & Mech-Viz-x.x.x/Mech-
Vision

° Mech-Viz.C: /Mech-Mind/Mech-Vision & Mech-Viz-x.x.x/Mech-Viz

6. Inthe Confirm window, confirm that the installation path is correct and then click the [ Install]
button.

7. Inthe Install window, wait for the installation to complete.

8. After the software is installed, in the Finish window, click the [ Finish ] button.

If the installation fails, refer to the error message in the Finish window and the Troubleshoot
Common Installation Issues section to troubleshoot the issue.

Access] to add the software to the firewall whitelist. Otherwise, the software may not be able

o When you first open the software, if your IPC or PC displays a security alert, click [ Allow
to detect the camera due to the firewall blocking.

Upgrade Software

The software does not support direct upgrade from a version earlier than 1.6.0 to the current
version. If you want to upgrade the software running an earlier version than 1.6.0 to the
current version, uninstall the earlier software version, and then install the new software
version. Before upgrade, read carefully the Before You Upgrade section.

To upgrade the software, follow these steps:

1. Copy the software installation package to a specified directory on the IPC or PC, such as
“D:/project”’, and decompress it.

2. Double-click the software installation file(.exe file) and open Mech-Vision & Mech-Viz Setup
Wizard. The Upgrade window is displayed.
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3. Inthe Upgrade window, click [ Upgrade and delete history versions].

(r') To preserve the historical version, rename the installation folder of the historical version

e before performing this step.

4. Wait until the upgrade operation is completed.

Uninstall Software

If you do not need to use Mech-Vision or Mech-Viz, you can uninstall it using any of the following

ways:

- Uninstall software using the Setup Wizard (recommended)

+ Uninstall software using Windows Control Panel

Uninstall Software Using the Setup Wizard

To uninstall the software using the Setup Wizard, follow these steps:

1. Double-click the decompressed software installation file(.exe file) and open Mech-Vision &
Mech-Viz Setup Wizard. The Maintain window is displayed.

2. In the Maintain window, click the [ Uninstall ] button.

3. In the Uninstall window, click either [ Keep user configuration files ] or [ Do not keep user
configuration files].

4. Wait until the uninstall operation is completed.
Uninstall Software Using Windows Control Panel

To uninstall the software using the Windows Control Panel, follow these steps:

1. Open the Control Panel on the IPC or PC.
2. Select Program » Uninstall or change a program.

3. Right-click the software to uninstall, and then click [ Uninstall ].

installed software products will be displayed as “Mech-Vision & Mech-Viz x.x.x" as a

o If you use the installation package Mech-Vision & Mech-Viz to install software, all
whole in the program list.

4. Wait until the uninstall operation is completed.

Repair Software

If Mech-Mind software fails to work normally due to certain exception, you can use the repair
function to reinstall the software.

To repair the software, follow these steps:

1. Double-click the decompressed software installation file(.exe file) and open Mech-Vision &
Mech-Viz Setup Wizard. The Maintain window is displayed.

2. In the Maintain window, click [ Repair].

© 2024 Mech-Mind Robotics Technologies Ltd.
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3. Wait until the repair operation is completed.

Modify Software Installation

After the installation package Mech-Vision & Mech-Viz is installed, to modify software installation,
follow these steps:

1. Double-click the decompressed software installation file and open Mech-Vision & Mech-Viz
Setup Wizard. The Maintain window is displayed.

2. In the Maintain window, click [ Modify ].

3. Inthe Select Product window, select the products or components to install, or clear the
products or components to uninstall.

4. Complete remaining installation operations.

Software License Agreement

For the license agreement of Mech-Vision and Mech-Viz, refer to End-User License Agreement.

Troubleshoot Common Installation Issues

Failed to Start the Setup Wizard
Symptom:

After double-clicking on the installation file, the setup wizard could not be started properly or
crashed.

Possible Cause:

There is not enough space on the system drive.

Troubleshooting Procedure:

Check whether the available space on the system drive is larger than the size of the installer.
- If the available space on the system drive is smaller than the size of the installer, delete

unnecessary files to free up the space, and then reinstall. If the issue still exists, contact Mech-
Mind Technical Support.

- If there is enough space on the system drive, contact Mech-Mind Technical Support.

Installation Failed

Symptom:

An error message saying “Installation failed.” appeared during the installation.
Possible Causes:

- Corrupted installer or missing files.

« The current user does not have administrator access.
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+ Another Wizard is performing the installation or the Windows system is being upgraded.

+ Other reasons.
Troubleshooting Procedure:

1. Obtain a new installer and check its integrity, and then try the installation again.
o If theissue is resolved, the troubleshooting is completed;
o Otherwise, proceed to step 2.
2. Right-click the installer and select “Run as administrator” to reinstall.
o If the issue is resolved, the troubleshooting is completed;
o Otherwise, proceed to step 3.

3. Try the installation again after the installation of other software completes or after the
Windows system upgrade completes.

o If theissue is resolved, the troubleshooting is completed;
o Otherwise, proceed to step 4.

4. Restart your IPC or computer and try the installation again.
o If the issue is resolved, the troubleshooting is completed.

o If the issue still exists, click the “installation log” link in the Finish window to collect
installation logs and send them to Mech-Mind Technical Support.

© 2024 Mech-Mind Robotics Technologies Ltd.
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Welcome to use Mech-Vision User Manual.

Mech-Vision is a cutting-edge machine vision software independently developed by Mech-Mind.
Through its fully graphical interface, advanced machine vision applications such as piece picking,
high-precision positioning, assembly, industrial inspection/measurement, and automatic path
planning can be completed without the need for coding.

This manual consists of the following chapters:

No. Chapter Content
) Introduction to software functions, terms and concepts related
Introduction to Mech- o i
T - to machine vision, user interface, and the general workflow of
Vision : . . .
creating solutions in Mech-Vision
2 Quick Guide of A Common operations with Mech-Vision
Common Operations
3 Step Reference Guide  Reference guide for using Steps and Procedures
4 Guide to Production Introduction to configuration and usage of the production
Interface interface
5 giirgjde-Eye Calibration Introduction to concepts and know-hows of hand-eye calibration
6 Measurement Mode Introduction to the basics of the measurement mode and key
Guide algorithms
7 Supplementary Tools  User guide for common tools in Mech-Vision
3 User Guide of Deep Introduction to deep learning in the 3D vision-guided robot

Learning

picking scenarios

4.1. Introduction to Mech-Vision

4.1.1. Terms and Concepts

This section introduces the key terms and concepts related to machine vision.

Solution and Project

Solution library

A resource library that provides typical solutions or projects (with example data) coming from
different application scenarios.

Solution

A solution is a collection of functional configurations and data for robot, communication, vision
processing, and path planning required for a vision application.

Project

A project refers to a Mech-Vision project. One or more projects constitute a project. Projects
cannot be used independently and must belong to a solution.
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Step

Steps are the basics of a project. A Step is a minimum algorithm unit for data processing. By
connecting different Steps in a project, you can achieve different data process tasks.

Procedure

A Procedure groups the Steps whose functions are closely related and achieve a specific
purpose concertedly in the project.

Parameter recipe

Parameter recipes are sets of parameter settings that need to be adjusted according to
different situations for the same project. With parameter recipes, you do not need to build
multiple projects with the same logic and configure their parameters differently to meet
different on-site requirements. Instead, you will only need to switch between parameter recipes
in one project to make it applicable to various scenarios and therefore the productivity can be
increased.

Hand-Eye Calibration

Hand-eye calibration

Hand-eye calibration establishes the transformation relationship between the camera and robot
reference frames. With this relationship, the object poses determined by the vision system can
be transformed into those in the robot reference frame, which guides the robot to perform its
tasks.

Intrinsic parameters

Intrinsic parameters are measures of the properties of a camera itself, including the focal
length, the lens distortion, etc. These parameters are usually calibrated and stored in the
camera before the camera leaves the factory.

Extrinsic parameters

Extrinsic parameters define how poses are transformed between the camera reference frame
and the world reference frame.

Euler angles

Euler angles are used to describe the orientation of an object in the 3D space. The object’s
rotation in the 3D space can be denoted by 3 angles, i.e., pitch, yaw, and roll.

TCP (Tool Center Point)

Tool center point is the pinpoint at the end of the robot tool. In order to complete tasks such as
picking, we usually say that the robot should move to a specific point in space, which actually
means its TCP should move to that point.

Vision Processing

Point cloud
A point cloud is a set of data points in space that represents a 3D shape or object.

Pose
The position and orientation information that are used to guide the robot.

Mask

Specified images, shapes, or objects are usually selected to mask the image (partial or all) to
control the area to process or the processing. The particular image or object used for masking
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is called a mask.

ROI (Region of Interest)

The region of interest excludes surrounding parts unnecessary for vision data processing in the
scene. Such parts may be background objects, pallets, bin edges, etc.

Deep Learning

Model Package

After a model has been trained in Mech-DLK, it can be exported as a model package, which
contains one or more models. In Mech-Vision, the model package can be used for the inference

of the image data.

Super Model Package

A universal model provided by Mech-Mind used to recognize cartons or sacks. If the
recognition performance is unsatisfactory, Mech-DLK can be used to fine-tune the model.

4.1.2. User Interface

This part introduces Mech-Vision's Welcome interface and Home interface.

Welcome Interface

If there is no autoloaded solution or project, Mech-Vision will display the Welcome interface when
you open it, as shown below.

Create from solution

New blank solution
library

Open solution Open project

Recently used

(r') Hover the mouse cursor over the “?” in the lower right corner of a quick entry card to check

e the introduction to this card.

The Welcome interface of Mech-Vision consists of the following parts.

No. Area Description
1 Version information Check version information and release notes.
2 Quick entry Quick access for the user to open a solution, open a project,

create a solution from solution library, and create a new
blank solution.
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No. Area Description
3 User Manual Click the button to view Mech-Vision's user manual.
4 Recently used Quickly open recently used solutions or projects.

Home Interface

Leave the Welcome interface and you will enter the Mech-Vision Home interface, as shown below.

The Home interface of Mech-Vision consists of the following parts.

No. Area

T Menu Bar

2 Toolbar

3 Project List

4 Step Library

5 Project Toolbar
Graphical Programming

6
Workspace

7 Log

8 Project Configuration Pane

4.1.2.17. Menu Bar

Description

Include File, Edit, View, Robot and
Communication, Camera, Deep Learning,
Toolkit, Settings, and Help.

Include buttons to quickly access tools and
functions.

Display opened solution, project name, and
their status, including communication status
and autoload status.

Include all the Steps needed to create a
project.

For project saving, running, and debug output,
etc.

Edit the processing or logical flows of a vision
project.

Display the log in real-time while running a
project; for user to find the execution record of
a certain moment in this panel.

Include Debug Output, Step Parameters,
Project Assistant, Step Quick Info, History, and
Step Comment List.

File(E} Edit{E}] View(d) Robotand Commnunication(R) Camera(C) DeepLearning(D) Toolkit(T) Settings(S) Help(H)

© 2024 Mech-Mind Robotics Technologies Ltd.
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The menu bar provides basic functions related to projects, as well as supplementary tools like
Camera and Deep Learning.

File

Used to manage solutions and projects.

Option Description Shortcut

New Solution Create a new empty solution Ctrl+Shift+N

New Project Create a new empty project Ctrl+ N

Create from Solution Choose and create a solution from the N/A

Library solution library

Open Solution Open an existing solution N/A

Open Project Open an existing project Ctrl+0

Open Recent... Show recently opened projects. Click the N/A
project name to open it

Open Executable File in Open the installation folder of the software N/A

Explorer

Save Solution Save changes to the current solution Ctrl+Shift+S

Save Project Save changes to the current project Ctrl+S

Save Project To JSON Save the project, and save the VIS file as N/A
JSON

Save Project As Save the project under a specified directory N/A

Backup Solution Back up the solution content within specified  N/A
time range to a specified path

Close Solution Close selected solution N/A

Exit Close the project and exit Mech-Vision Ctrl+Q

Edit

Option Description Shortcut

Undo Undo the previous action Ctrl+Z

Redo Redo the undone action Ctrl+Y

View

Providing settings for managing components of the user interface. Check the box before each

option to display the corresponding component in the software.

Option

Description

Project List Display/Hide the Project List panel. Selected by default.

Step Library Display/Hide the Step Library panel. Selected by default.

Display the Debug Output panel. Selected by default, and
cannot be unselected.

Debug Output
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Option Description

History Display/Hide the History panel. Selected by default.

Project Assistant Display/Hide the Project Assistant tab. Selected by default.

Step Quick Info Display/Hide the Step Quick Info tab. Selected by default.

Step Comment List Display/Hide the Step Comment List tab. Selected by
default.

Step Parameters Display/Hide the Step Parameters tab. Selected by default.

Step Input Source Selection Display/Hide the Step Input Source Selection panel.
Unselected by default.

Measurement Output Display/Hide the Measurement Output panel. Unselected by
default.

Result View Display/Hide the Result View (In Measurement Mode).
Unselected by default.

Log Display/Hide the Log panel. Selected by default.

Toolbar Display/Hide the toolbar. Selected by default.

Default Layout Turn Mech-Vision User Interface into default layout.

Format Grid Display/Hide format grid and assist line. Unselected by
default.

Align Type Choose the type of assist line (Align Anchor, Align

Horizontal, Align Vertical).

Robot and Communication

For configurations related to robots and communication.

Option Description

Robot Communication Configuration Configure the robot and the communication
interfaces.

Adapter Generator Can be used to generate Adapter programs
quickly.

TCP/IP Command Reference for Standard Can be used to check the Standard Interface

Interface TCP/IP commands.

Robot Library Tools Import/export robot models

Camera

For image capturing, camera calibration, and parameter analysis.

Option Description Shortcut
Camera Calibration Standard: normal calibration N/A
procedure
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Deep Learning

Deep Learning Model Package Open deep learning model N/A

Management Tool management tool

Deep Learning Server Start/Stop deep learning Ctrl+Alt+D
server(s)

Toolkit

Providing supplementary tools that are commonly used for debugging.

Matching Model and Pick Point Editor For generating point cloud models for the object, editing
point cloud models, and adding pick points

Error Analysis Tool Check camera intrinsic parameter accuracy, robot
absolute accuracy and other items, and troubleshoot the
accuracy errors which occur during recognition and
positioning

Options

Providing commonly used settings.

Set Mech-Center Address Set the IP address of Mech- N/A
Center
Lock Project Enter passwords to lock N/A

opened projects

Option Change common settings like  Ctrl + Shift + O
language, unit, etc.

Help

Used to check the current version information, change log, manual, etc.

About Check current version information

What's New Open the Release Notes in browser

User Manual Open the User Manual in browser

Online Community Access to Forum, Download Center, Video Tutorials, and
Feedback

About Plugins Select the plugins you'd like to display, and check the

name, version, description, and location of the plugins
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4.1.2.2. Toolbar

You can create a solution from Solution library, apply in-built tools, and change project mode.

Option Description

Standard Mode For switching modes between Standard Mode and
Measurement Mode

Create from Solution Library For creating a solution quickly

Robot Communication For selecting robot models and setting interface

Configuration communication

Camera Calibration (Standard) For starting the standard camera calibration procedure

Matching Model and Pick Point For generating point cloud models for the object, editing

Editor point cloud models, and adding pick points

Production Interface For configuring the Production Interface to monitor the

Vision System status, add new workpieces or switch
workpiece types, and troubleshoot errors, etc

4.1.2.3. Project List

Project list displays opened solutions and projects and their status, including interface
communication status and autoload status.

Area 1 is the solution name, area 2 is the project name, as shown in below.

Project List

7 Vis_BrakeDisc

F Vis_CreateModel

o + Hover the cursor over [Ji] to check the introduction of solution and project.
+ Click [l to check the user manual on “solution”.
Operating Instructions on Solutions

Select a solution, right-click it to choose actions such as Close Solution, Open Solution in Explorer,
Autoload Solution, Rename Solution, etc. For the detailed operation, please refer to Operation
Guide: Solution Guide.
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Close Solution

Open Solution in Explorer

Mew Project
[1 Autoload Solution
Rename Solution

Back Up All

The options and their description are as follows.

Option Description

Close Solution Close current solution

Open Solution in Explorer Open the folder in which the solution is located
Autoload Solution Autoload all projects in the solution

Rename Solution Rename the solution

Back Up All Back up the solution

Operating Instructions on Projects

Select a project, right-click it to choose actions such as Close Project, Open Project in Explorer,
Autoload Project, Rename Project, etc. For the detailed operation, please refer to Operation Guide:
Project Guide.
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Open Project in Explorer

L

Rename Project

Delete Project

Back Up Project
Back Up All

The options and their description are as follows.

Option
Close Project

Open Project in Explorer

Autoload Project
Rename Project
Delete Project
Back Up Project
Back Up All

Reset Project IDs

Description
Close current project

Open the folder in which the
project is located

Autoload the selected project
Rename the selected project
Delete the selected project
Back up the selected project

Back up all projects in the
solution

Reset the project’'s ID

Vision System Software Manual

Shortcut
Ctrl+W
N/A

N/A
N/A
N/A
N/A
N/A

N/A

When there is an opened solution and a project unassigned to any solution, you can choose

Move/Copy to Current Solution.

© 2024 Mech-Mind Robotics Technologies Ltd.
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Close Project

Open Project in Explorer

[] Autcload Project

Rename Project

Delete Project

Back Up Project

Back Up All

Move to Current Selution
Copy to Current Solution

Pack as Solution

The options and their description are as follows.

Option Description
Move to Current Solution Move the selected project into the currently opened solution
Copy to Current Solution Copy the selected project into the currently opened solution

4.1.2.4. Step Library

Step library includes all the Steps needed to create a project, as shown below.
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Step Display

step Library

. 20 Feature Detector

2D General Processing

20 Matching

30 Feature Detector

30 General Processing

10 Matching

30 Model Creation

Advanced Components

Anthmetic

Camera

Communication

Deep Learning

Ly Depalletizming & Palletizing

" Drawing

Label
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Expand/Collapse Steps

When all groups of Steps are expanded in the Step library, click the right mouse button and click
Collapse to fold all the groups.

show all

When all groups of Steps are collapsed in the Step library, click the right mouse button and click
Expand to unfold all the groups.

. Expand

=] Show all

Show Frequently-Used Steps/ Show All

When the button on the right of the search bar is like [@], the Step library displays frequently-used
Steps only. For all Steps to be displayed, you can click the button @] on the right of the search bar.
When the button turns into [§] all Steps will be displayed in the Step library. You can also right-click

in the Step Library area and select [ Show All ].
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=] Show all

Find Steps

Type a Step name in the search bar to find related Steps. The Step name typed in the bar can be
both the full name or key information about the name.

Step Library

2D General Processing

Type in full name of the Step and you can find the exact search result. The Step “Morphological
Transformations” is taken as an example in the figure below.

Step Library

). Morphological Transformations|

v |_] Mack Processing

¥ Add / Remove Areas in Masks

f I Morphological Transformations

Type in key information about the Step, Steps related to the information will be displayed. The Step
“Pose” is taken as an example in the figure below.
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Step Library

' 2D General Processing

¥ Image Transform

mﬂ' Rotate Images by Specified Poses

' 20 Matching
¥ Calc Pose
Calc Poses and Dimensions of Rectangles
[L1] Record Criterion Pose and Calc Transformation
Ternplate Matching
E Transform lmage
3D General Processing
W Calc Pose

Calc Poses and Dimensions from Planar Point ...

Q For more basic operations relevant to the steps, please refer to Operation Guide: Step-Guide.

4.1.2.5. Project Toolbar

Providing buttons for running, stopping and debugging the project.

Debug Output @)

Option Description

Save Project Save the project

Undo Undo the action

Redo Redo the action

Run Run the project

Debug Output When switched on, additional debug information will be
displayed

4.1.2.6. Graphical Programming Workspace

During software tuning, the graphical programming workspace is an integral part of editing the
logical flows of a vision project. Lines between Steps indicate data flow in standard editing mode
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and processing procedure in measurement mode.

<1 agey/ D «TageyCoke AChoUS(OT) > | CloudDYT RGE)s  <ENRg
Camem Deph nage | Camem Colorimage | PolntOowd | Colomd Point Qoud | Collor image Path

w0oudE YT Momal)>  aChoudXYT Mommal -
Foint Clowds’ Boundary  Radu od Point Cloudwithi omvak

Right-click the blank space in the graphical programming workspace, a context menu with multiple
options will pop up, and you can select options in this menu according to your needs.
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Mavigate Down
Switch to Simplified Meode
Copy

Cut

Delete

| Find Step

Edit Procedure Parameters

Split Procedure into Steps

Load Procedure from File...
Save Procedure to File...
Save Procedure as Template
Comment Selected Step
Set Execution Flags of All Steps
Select Step Port Info to Display
The options and their description are as follows.
Option Description

Navigate Up Move to the previous level of
the Procedure

© 2024 Mech-Mind Robotics Technologies Ltd.

Vision System Software Manual

PHDDWH

Ctrl+F
Alt+Shift+F

Ctri+A

Shortcut
PgUp
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Option

Navigate Down

Switch to Simplified Mode

Copy
Cut

Paste
Delete
Find Step

Format
Select All
Save Screenshot

View Data Flows

Edit Procedure Parameters

Pack Steps as Procedure
Split Procedure into Steps
Load Procedure from File
Save Procedure to File

Save Procedure as Template

Comment Selected Step

Set Execution Flags of All Steps

Description

Move to the next level of the
Procedure (Right-click the
Procedure to activate the
option)

Switch all Steps of the current
project to simplified mode

Copy the Step

Cut the Step

Paste the Step

Delete Steps or data flow
Find Steps in current project

Auto arrange Steps in current
project

Select all Steps and data flows
in current project

Save project screenshots to a
designated folder

Display data input or output in
the debug output window
(Right-click a data flow to
activate the option)

Edit displayed parameters of a
Procedure (Right-click the
Procedure to activate the
option)

Combine multiple selected
Steps into a Procedure

Split a selected Procedure into
multiple Steps

Load a Procedure from an
existing JSON file

Save a Procedure as a JSON
file

Save the selected Procedure to
the “Custom” category in the
Step Library

Add comments on the selected
Step

Cancel Text Output
Set/Cancel Reloading Files

Set/Cancel Continuing Given
No Output

© 2024 Mech-Mind Robotics Technologies Ltd.
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Shortcut
PgDown

N/A

Ctrl+C
Ctrl+X
Ctrl+V

Del

Ctri+F
Alt+Shift+F

Ctrl+A

N/A

Shift+V

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A
N/A
N/A
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Option Description Shortcut
Select Step Port Info to Display Show Type and Name Ctri+Alt+A

Show Name Only Ctrl+Alt+N

Show Type Only Ctri+Alt+T

4.1.2.7. Project Configuration Pane

This pane provides panels and tabs including Debug Output, Step Parameters, Project Assistant,
Step Quick Info, History and Step Comment List.

If you cannot find the tab you need in the project configuration pane, go to menu bar > View
and check whether the checkbox before the option is selected.

© 2024 Mech-Mind Robotics Technologies Ltd.
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Debug Output

]

No debug output to display

e the debug outputs of all Steps.
ct, left click and drag on a Step ingle Step Execution” button, and click
utput” to see the Step's output.

Step Parameters

Step Parameters Project Assistant  Step CQuick Info  History  Step Comment List

Debug Output

When Debug Output in the Project toolbar is switched on, this panel displays the output of Steps as
the project is executed. For details, please refer to Run Steps and View Outputs.
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Debug Output - 30 Fine Matching (1)
3D 3D Fine Matching_1

-Axis: red; Y-Axis: green; Z-Axis: blue

Press r/R to reset camera view point to center.

Step Parameters

This panel displays the common parameters of the selected Step.
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Step Parameters

Step Mame 3D Fine Matching_1

Execution Flags
Parameter Tuning Level
Model Settings
Model Selection  Customn
Maodel File  model/model.ply
Geo Center Point File model/geo_center.json

Cloud Orientation Calculation

Point Orientation Calc Mode Origin
Matching Method GMM

Matching Mode Standard
Standard Deviation  20.000 mm
Speed Up on Large Object Q...
Sample Settings
Sampling Interval  5.000 mm
Validation Settings
Confidence Thresheld  0.200
Search Radius  5.000 mm
Output Settings
Maximum Mumber of Detect...

Results Visualization

Show Matching Results &

Step Parame.. Project Assist.. Step Quickl.. Hist.. 5tep Comment ...

By default, only frequently used parameters will be displayed in the Step Parameters panel. If
you cannot find the parameter you need, please right-click on the blank area in the Step
Parameters panel and select Show all parameters in the context menu.

O

=] Show all parameters

Project Assistant

This tab provides tools of Parameter Recipe, Data Storage, and Scene Point Cloud for Reference.
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Project Assistant

l.‘“ #4 Scene Point Cloud for Reference

Select an output port from a Procedure/Step

/ Procedure/Step name: From Depth Map to Point Cloud (1)

Output port name: Colored Point Cloud

Frame of reference: | Camera r

Step Quick Info

This tab displays a description of the function, usage scenario, input and output of the selected
Step, as shown below.
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@,

History

Step Quick Info

Function description:
This Step performs fine matching between the model point cloud and the
original point cloud and outputs the finely calculated object poses.

Usage scenario:
This Step performs more accurate matching based on candidate poses output
by the Step "30 Coarse Matching” and outputs accurate object poses.

Input:

® | ist of point clouds to match (usually the same as the point cloud list
used in the Step Coarse Matching").

® Candidate pose list (usually obtained from 30 coarse matching).

® Classification label list corresponding to the pose list (usually the
classification label list is output by a deep learning Step).

® Confidence list corresponding to the pose list (usually the confidence
list is output by a deep learning Step).

Output:

® Pick point list.

® The model point cloud list generated by the matching results.
® Model-to-scene transformation reference pose list,

® | ahel list corresponding to the pick point list.

® Confidence list corresponding to the pick point list.

® Matching score list corresponding to the pick point list,

Press F1 to open the corresponding chapter in the User Manual for more detailed information

on the selected Step.

Vision System Software Manual

This tab provides a list of all the actions you have taken to program the project. Clicking an item to
return the project to that point in history.

© 2024 Mech-Mind Robotics Technologies Ltd.
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History

<empty>

Add step (Adjust Poses_1)

Add step (Plan Object Poses at Placements_1)

Delete step vert Circles to 2D P ‘_'I]
Add step (From Shape2DList to Pose2DList_1)
Delete step (From ShapedDList to Pose2DList_1)

(r) If you want to use the Step Input Source Selection or Measurement Output window, you can

e select the corresponding option in View.

Step Comment List

This tab displays the comment added to the selected Step. For detailed instructions on Step
comment, please refer to Introduction to Step Comments.
Step Comment List
1] 3D Fine Matching_2
This Step performs fine matching between the model point cloud

and the original point cloud and outputs the finely calculated
object poses.

4.1.2.8. Log

This panel displays the log in real-time while running a project/solution. You can check the
execution record of a certain moment in this panel.

A vis_HATET L P 14/2022

/i /vis BT T+ b $4/2022-08-31

There are four levels of log, as shown below.

Level Description

D Debug information

i Information

W Warning Information
E Error information

You can click the icons of log level in the lower left-hand corner of the log panel to choose the type
of log information you'd like to display. Anicon in blue indicates that log information of this level is
displayed. When an icon is in gray, the log information of this level is hidden.
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Double-click a single line in the log, select the content, and right-click and select Copy in the pop-up
menu to copy the selected content.

Service address: 127.0.0.1:53¢

Timeout: 100 ms

Error code: 4
Error message: Deadline Excecucy

Select All  Ctri+A

4.1.3. Getting Started with Solution

This part introduces how to build a vision solution.

A solution is a collection of functional configurations and data for robot, communication, vision
processing, and path planning required for a vision application.

A solution goes through five processes from creation to execution, as shown in the diagram below.

. Configure robot Perform Robot Debug and
Create a solution anq . Hand-eye optimize solution
communication, Calibration

Create a Solution

A solution is a collection of functional configurations and data for robot, communication, vision
processing, and path planning required for a vision application. You need to create a solution first
before moving on to the next process.

1. Create and save a solution.
2. Autoload the solution.

3. Build the project.

Configure Robot and Communication

After creating a solution, you can start configuring the robot and communication.

Communication refers to the information exchange and transmission between the vision side and
the robot side. To ensure normal communication between the vision side and the robot side, you
need to configure the communication on both sides.

In Mech-Mind Vision System, there are two communication methods: interface communication
and master-control communication. And interface communication can be divided into Standard
Interface communication and Adapter communication.

Interface communication

For Interface communication, you need to configure both the vision side and the robot side, and
make a trial run to ensure normal communication between the two sides.
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Notably, different brands of robot require different methods of communication between the robot
side and the vision side.

1. Configure communication on the vision side.

2. Configure communication on the vision side, and test whether the robot side and the vision
side can communicate normally with each other.

Master-Control Communication

For master-control communication, you need to configure communication on the robot side, and
then test whether the robot side and the vision side can communicate normally with each other.

1. Configure communication on the robot side.

2. Test whether the robot side and the vision side can communicate normally with each other.

Perform Robot Hand-Eye Calibration

When robot and communication configuration is completed, you can move on to robot hand-eye
calibration.

Hand-eye calibration refers to the process of establishing a positional correspondence between
the camera frame and the robot frame. During the process, the object poses defined by the vision
system are transformed into poses under the robot frame, so as to guide the robot to perform
picking tasks.

Robot Hand-eye Calibration is an essential process, as the calibration results and stability have a
direct influence on the robot's accuracy.

Tune and Improve the Solution

When the above processes are all completed, you can start running and tuning the project.

1. Run and tune the project.

2. Run the Steps and check the visualization outputs.
Pick
After running and tuning the project, you can apply it to a real robot to perform picking tasks.
- If Interface communication is adopted, you need to write a program for the robot to pick and

place objects, and, through the Standard Interface, trigger the Mech-Vision solution and
acquire its vision point and waypoint outputs from the Mech-Vision project.

- If master-control communication is adopted, you need to plan the waypoint by building a
Mech-Viz project.

4.2. Quick Guide of Mech-Vision

This chapter provides operating instructions for functions of Mech-Vision.
Read the section below for Quick Guide for Solution Library.

Quick Guide for Solution Library
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Read the section below for Quick Guide for Solutions and Projects.
Quick Guide for Solutions

Quick Guide for Projects

Read the section below for Communication Settings Guide.

Quick Guide for Robot and Communication Configuration

Read the section below for Step Usage Guide.

Basic Procedures for Using Steps

4.2.1. Quick Guide for Solution Library

In the Mech-Vision Solution Library, you can find example solutions and projects with data for
different industries.

This chapter introduces you to basic procedures for using the solution library.
Open the Solution Library

Search for a Solution or Project

Check the Brief Introduction to Solutions or Projects

Open User Manual for Solutions and Projects

Create a Solution from the Solution Library

4.2.1.1. Open the Solution Library

This section introduces how to open the Solution Library.

Open from the Welcome Interface

After you open Mech-Vision, click [ Create from solution library] in the Welcome interface to open
the Solution Library.

Create from solution

Open solution Open project library MNew blank solution
ary

There are some built-in resources in the Solution Library. If you want to view more solutions, click
[ More] at the bottom of the interface. Click [ Yes ] in the pop-up window to start loading.
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After the resources are loaded, you can see more solutions in the Solution Library, as shown
below.

< Solution Library 2

L) Palletizing & Depalletizing @ Locating & Assembly ] Piece Picking 3 Quality Inspection

+ Solution: a collection of configurations and data of robot communication, vision
processing, path planning and other functions for implementing the vision application.

+ Featured: indicates that the solution can be widely used and its feasibility has been
verified on site for many times.

+ Built-in: indicates that the solution is locally installed with the software, and there is no
need to download it.

Open from the Main Interface

If you have already entered the main interface, you can open the Solution Library in either of the
following three ways.

- Click [ Create from Solution Library ] in the toolbar.

* Select File » Create from Solution Library in the menu bar.

4.2.1.2. Search for a Solution or Project

In the solution library, you can search the solution or project you need according to the usage
scenarios. In the workpiece loading scenario, you can filter your search by the Workpiece
appearance and Difficulties.

The following steps shows how to search for a Mixed object specifications Brake Discs project in
the Workpiece Loading scenario.

1. Filter search by usage scenarios. Click [ Workpiece Loading] on the top of the Solution Library,
and all solutions and projects of this scenario will appear in the window.
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Selution Library (7

I:I ) Palletizing & Depalletizing @ Locating & Assembly [ Piece Picking &3 Quality Inspection

Whesl, plate, flat cylinder ~ | Mixed object specifications

2. Filter search by workpiece appearance. Select Wheel, plate, flat cylinder in the drop-down
menu of Workpiece appearance box, and solutions and projects related to the wheel, plate,
and flat cylinder in the workpiece loading scenario will appear in the window.

Wheel, plate, flat cylinder
Wheel, plate, flat cylinder
Colurnn, stick, pole
Shaft
Cuboid
Small piece

Special shape

3. Filter search by difficulties. Select Mixed object specifications in the drop-down menu of
Difficulties box, and solutions and projects of mixed object specifications will appear in the

window.

object specifications
Defective point cloud
Mixed object specifications
Severe overlap
Background distraction/noise

Special recognition requiremnents

Then you can find the Brake Discs project in the Solution Library.

Solution Library (2

) Palletizing & Depalletizing @ Locating & Assembly £2 Quality Inspection

Wheel, plate, flat cyfinder

4.2.1.3. Check the Brief Introduction to Solutions or Projects

If you want to know more about the solution or project, click the solution or project in the Solution
Library, and a brief introduction will appear at the bottom of the interface.
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) Palletizing & Depalletizing @ Locating & Assembly =l Piece Picking 53 Quality Inspection

Crankshafts (Large)
Large crankshafts, orderly a

3D matching to recognize the crankshafts,
the bin need to be picked.

Crankshafts (Large)
Larg nkshafts, order g ] ! metal. Slightly reflective surface.

Use the 3D matching to recognize the crankshafts, and output the pose of the highest crankshaft each time. All crankshafts in
the bin need to be picked.

4.2.1.4. Open User Manual for Solutions and Projects

The user manuals for solutions and projects cover the content of usage scenarios, technical
specifications, project difficulties, vision solutions, parameter tuning recommendations, etc.

If there is a user manual for the solution or project, after you click the project or solution in the
Solution Library, you can see a [ Learn More ] button in the lower right corner of the interface.

To check the user manual of a certain project or solution, click the [ Learn More button ] in the
lower right corner.

@ Locating & Assembly =l Piece Picking 53 Quality Inspection

Turnover Box

Opened turnover box.

with lids, turnows

more details and in:

Solution name

4.2.1.5. Create a Solution from the Solution Library

To create a solution from the Solution Library, open the Solution Library first. Then, select the
solution, and enter a Solution name and Path to store the solution. Click [ Create] in the end.
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ocating & Assembly =l Piece Picking &3

Turnover Box
Qpened turnover box.

e-specification turnover boxes coming orderly. A small quantity of missing paint clouds and cases of tight piling are

not applicable: Turnov
ured within the field of

Solution name| turnover_box

If an error message as shown below pops up, there is no available solution on the server. Please
check your network connection first, and retry after the network connection is successful. If the
problem still exists, please contact Mech-Mind Technical Support.

ce information. Please check the network

4.2.2. Quick Guide for Solutions

Solution is a collection of configurations and data of robot communication, vision processing, path
planning and other functions, which are all integral components of a vision application.

This chapter introduces you to basic procedures for using projects.
Create and Save Solution

Open Solution

Autoload Solution

Rename the Solution

Close the Solution
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Understand Solution Structure

4.2.2.1. Create and Save Solution
This section introduces how to create a new solution and save it.
Create a New Solution

Create a New Blank Solution

There are three ways to create a new blank solution:

« Click [ New blank solution] in the Welcome interface.

Create from solution

Open solution Open project lib New blank solution
° ibrary

* Select File » New Solution in the menu bar of the main interface.

- If you do not open any solution or project in the main interface of Mech-Vision, click [ New
Solution] in the middle of the interface.

-+ Mew solution

5 Open recent solution...

Create from Solution Library

Please refer to Create a new solution or project from Solution Library.

Save the Solution

After a new solution is created, it is recommended to specify a directory to save the solution in
time.

There are two ways to save the solution:

* Select File » Save Solution in the menu bar.
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* Press Ctrl + Shift + S on the keyboard.

« If you want to rename the solution, please refer to Rename the Solution.

é « If you want the solution to be opened automatically the next time you open the software,
please refer to Autoload Solution.

4.2.2.2. Open Solution

This section introduces how to open a solution.

Open an Existing Solution

There are two ways to open an existing solution:

« Click [ Open solution] in the Welcome interface, and select the solution folder in the Open
Solution window.

* Select File » Open Solution in the menu bar of the main interface, and select the solution folder
in the Open Solution window.

Open a Recently Opened Solution

There are three ways to open a recently opened solution:

+ Click Solution on the Solution/Project button in the Welcome interface, and double-click the
solution that you wish to open.

Recently used Solution | Project

* Click File » Open Recent... in the menu bar of the main interface, and then select the solution in
the context menu to open.

- If you do not open any solution or project in the main interface of Mech-Vision, you can see
two buttons in the middle of the interface. Select [ Open recent solution...], and select the
solution you want to open in the pop-up window, and then click Open.
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-+ Mew solution

5 Open recent solution...

brake_disc_loading

Fath:

4.2.2.3. Autoload Solution

If you want a solution to be opened automatically the next time you open Mech-Vision software,
please do the following step.

Right-click the solution in the Project List and select Autoload Solution, as shown below.
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Close Solution

Open Solution in Explorer

MNew Project

Autoload Solution
Fename Solution

Back Up All

Reset Project IDs

autoloaded. Therefore, the next time you open the software, you will enter the main interface

When Autoload Solution is selected, all the projects belonging to the solution will be
o of the software directly, and the Welcome interface will not appear.

4.2.2.4. Rename the Solution

This section introduces how to rename a solution.

To rename a solution, right-click the solution name in the Project List and select Rename Solution.
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Close Solution

Open Solution in Explorer

MNew Project
[] Autoload Solution
Eename Solution

Back Up All

Then, input a new name for the solution and press Enter to confirm.

Project List

v BE|

4.2.2.5. Close the Solution

There are two ways to close a solution:

+ Right-click the solution in the Project List and select Close Solution, as shown below.
Close Solution
Open Solution in Explorer

MNew Project

[] Autoload Solution

Eename Solution

Back Up All
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* Select File » Close Solution in the menu bar.

If there are unsaved changes in the project, a pop-up window as shown below will appear. You can
select one of the options according to your need.

save all project changes in

s will be dise d.

Dizcard Cancel

o Once you close the solution, all projects in the solution will be closed as well.

4.2.2.6. Understand Solution Structure

This section introduces the structure of a solution, which includes the configuration and data files
for functions required by a vision application, such as robot and communication, vision processing,
and path planning.

The following figure shows the structure of a solution.
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¥ (3 solution
v (D Project 1
ﬁ Calibration
D data
¥ [ resource
D 3d_matching

D roi
D config

ﬁ Project_1.vis
v (3 Project 2
B Project_2.vis

...

¥ (D Project n

¥ (3 planning_project
ﬁ planning_project.json
D model_library

v [ xxx.msoln

¥ (3 Robot
D Robot_model
[ Soft_limit

B Communication_configuration
¥ (3 Project_list
D Project_loading_order
ﬁ Deployment_settings

4.2.3. Quick Guide for Projects

Projects refer to Mech-Vision projects. A project must belong to a solution, or else it cannot be
used. In addition, a solution may include multiple projects.

This chapter introduces you to basic procedures of using projects.
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Create and Save Project

Rename Projects

Open Project

Run Project and Debug

Close Project

Autoload Project

Adjust Project ID

Move an Existing Project to a Solution

File Structure of a Mech-Vision Project

4.2.3.1. Create and Save Project

This section provides information on creating a new Mech-Vision project, saving the project, and
the naming convention of project names.

Create New Projects

Create from Solution Library

Please refer to Create a new solution or project from Solution Library.

Create a New Blank Project

There are three ways to create a new blank project:

- After creating a new solution, create a new blank project in it.
* Select File > New Project in the menu bar to create a new blank project.

* Press Ctrl + N on the keyboard to create a new blank project.

é You can only create a new project after creating a new solution.

Save Projects

You can save a single project in a solution or save all projects in the solution.
Save a Single Project
There are two ways to save a single project in a solution:

* Select File » Save Project in the menu bar to save a single project.

* Click [ on the left end of the project toolbar or press Ctrl + S on the keyboard to save a single
project.
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Save all Projects in the Solution

If you want to save all projects in a solution, select File » Save Solution in the menu bar to save all

projects in the solution.

Naming Convention of Project Names

The recommended naming convention of Mech-Vision projects is as shown below.

Components in the name
Vis

Object Name + Application
Scenario

No. or the position of the Camera

Specific or special function

Description

To distinguish Mech-Vision projects from Mech-Viz projects
(compulsory)

For example:
CartonDepalletizing/DiscBrakeMachineTending/ElectricMot
orAssembly/SpongeGluing/ParcelPicking

Camera No.: 1#CrackDetection1#HeatTreating1#
Camera Position: LeftCamera (optional)

Specific function:
Category1WorkpieceRecognition/ReflectiveWorkpieceRecog

nition/BinDetection/ModelMaking

Special function:
PointCloudStitching/ImageStitchingFromTwoCameras
(optional)

The table below provides some example names.
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Scenario

Single Robot Cell + Single Camera

Single Robot Cell + Multiple Cameras
Multiple Robot Cells + Multiple Cameras

Multiple Robot Cells + Multiple Cameras +
Function

One camera in the robot cell is used to enable
multiple functions

Vision System Software Manual

Example Name

Vis-CartonDepalletizing
Vis-DiscBrakeMachineTending
Vis-ElectricMotorAssembly
Vis-SpongeGluing

Vis-ParcelPicking
Vis-WorkpieceMachineTending-LeftCamera

Vis-CrankshaftMachineTending-
CrackDetection1#LeftCamera

Vis-CrankshaftMachineTending-
CrackDetection1#l eftCamera-
PointCloudStitching

Vis-RzeppadointMachineTending-
5#leftCamera-Category1WorkpieceRecognition

Vis-RzeppadJointMachineTending-
5#l eftCamera-Category2WorkpieceRecognition

Vis-RzeppadointMachineTending-
5#LeftCamera-BinDetection

Vis-RzeppadointMachineTending-
5#l eftCamera-ModelMaking

Vis-RzeppadointMachineTending-
5#RightCamera-
Category1WorkpieceRecognition

Vis-RzeppadointMachineTending-
5#RightCamera-
Category2WorkpieceRecognition

o When using English for naming, note that:

- Use abbreviations instead of full names if possible.

- Try not to use pinyin spelling.

« Use camel case in word combinations.

4.2.3.2. Rename Projects

Follow the instruction below to rename a project.

Right-click the project in the project list, and select [ Rename Project]. Input a new project name

and press Enter to confirm.
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Project List
v EH Test

1 Projectl

Open Project in Explorer
Rename Project

Delete Project

Back Up Project

Back Up All

Reset Project IDs

After you complete the above operation, the project folder and the VIS file in the folder will be
renamed as well.

4.2.3.3. Open Project

This section introduces how to open a Mech-Vision project.

Open an Existing Project

There are three ways to open an existing project:

- Click [ Open project] on the Welcome interface, and select the project folder in the pop-up
window. You do NOT need to open the folder and select the VIS file.

* Click File » Open Project (Shortcut Ctrl + 0) in the menu bar of the main interface, and select
the project folder in the pop-up window.

- Double-click the VIS file in the project folder to open Mech-Vision and autoload the project.

Open a Recently Opened Project

There are two ways to open a recently opened project:

« Click Project on the Solution/Project button in the Welcome interface, and double-click the
project you want to open.

Recently used

* Click File » Open Recent... in the menu bar of the main interface, and then select the project in
the context menu to open.

(r') « If you are using Mech-Vision 1.4.0 or later versions to open a project created in the

S previous versions, the original JSON project file will be saved as a VIS file, and the backup
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file will be saved as a BAK file.

* You can click File » Save Project To JSON in the menu bar to save the project as a JSON
file.

4.2.3.4. Run Project and Debug

Click [Run]in the toolbar or use the shortcut Ctrl + R to run the current Mech-Vision project, as
shown below.

P Run

When the project’s running result does not meet expectations, the project needs to be debugged.
First, it is necessary to locate the Step(s) of error by running the Steps one by one. The parameters
of Step(s) whose result does not meet expectations should be tuned. For each executed Step, the
execution time of the Step is displayed in the lower-left corner of the Step box, as shown below.

ge/Color- loud(eYZ)>  <Cloud(XYZ-RGB)>  <String-
CameraDepthImage ~ Camera ColorImage | PointCloud  Colored Point Cloud  ColorImage Path

<Image/Depth= <Image/Color-=> <Image=>
Camera Depth Image era Color Image. Original Image

From Depl

Time: 28ms

<wwuuAte | <Cloud(XYZ-RGB)>

PointCloud  Colored Point Cloud
<image> | <NumberListScaleParam> <NumberListRoi> | <image:
ROlimage  Scale Parameters ROI Parameters | Visualization Image

caleParar
ROlImage Scale Parameters

For detailed instructions, please see Step Reference Guide.

4.2.3.5. Close Project

You cannot close a single project that belongs to a solution. Instead, you can close the solution to
close all projects in the solution. The detailed instructions are as follows.

Right-click the corresponding solution in the project list, and select [ Close Solution] to close the
solution and all projects within it, as shown below.
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Project List

v EE Test > Solution

Open Solution in Explorer
Mew Project

Autoload Solution
Rename Solution

Back Up All

Reset Project IDs

If there are unsaved changes in the project, a pop-up window as shown below will appear. You can
select one of the options according to the actual requirement.

ve all project changes in

d", ALL project changes will be «

Dizcard Cancel

4.2.3.6. Autoload Project

If you want a project to be opened automatically the next time you open Mech-Vision software,
please do the following steps.

- When the project is not assigned to a solution, right-click the project in the project list and
select Autoload Project, as shown below.

Project List
¥ 2 Unassigned projects

F - -
Close Project Ctrl+W

Open Project in Explorer
O Autoload Project
Rename Project

Delete Project

Back Up Project

Back Up All

Pack as Solution
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- When the project belongs to a solution, right-click the solution and select [vision-operation-

guide:auto-load-solution::autoload-solution], and all the projects belonging to the solution will
be autoloaded.

4.2.3.7. Adjust Project ID

When “Autoload Solution” is selected, the projects belonging to the solution will be autoloaded as
well. Each project will be assigned a project ID, as shown below.

To adjust the project ID, follow these instructions:

1. Select and drag an project to adjust the display order of the project in the list. The result before
and after adjusting is shown below.

Here, only the display order of the project in the list is adjusted, and the project ID
remains unchanged. Resetting project IDs is still required.

2. Toreset the project ID, right-click the solution or one of the projects, and select [ Reset Project
IDs ]. The disordered project IDs will be re-sorted in descending order, and the project
corresponding to each ID will be changed.

Close Solution

Open Solution in Explorer
New Project

Autoload Solution
Rename Solution

Back Up All

Reset Project IDs

The result before and after resetting the project IDs is shown below.
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4.2.3.8. Move an Existing Project to a Solution

Follow the instruction below to move an existing project to a solution.

- After you create and save a new solution, right-click the unassigned project in the project list,
and select [ Move to Current Solution ] or [ Copy to Current Solution ], as shown below.

Project List
HE Test

¥ & Unassigned projects

F
Close Project Ctrl +W

Open Project in Explorer
0 Autoload Project
Rename Project

Delete Project

Back Up Project

Back Up All

Move to Current Solution
Copy to Current Solution

Pack as Solution

parameter of the Step, please check the path in the moved project and modify the wrong path

After you moved the project to a solution, if the absolute path or relative path is used in the
° to avoid errors.

- If you want to convert the project to a new solution, right-click an unassigned project in the
project list, and select [ Pack as solution ], and then click [ Yes ] in the pop-up window. Then the
project will be converted to a solution, and the parent folder of the project folder will be used as
the solution folder.
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¥ =, Unassigned projects

lf - - - L -
Close Project Ctrl+W

Open Project in Explorer
[ Autoload Project
Rename Project

Delete Project

Back Up Project

Back Up All

Move to Current Solution

Copy to Current Selution

Pack as Solution

When converting the project to a new solution, the parent folder of the project folder cannot
be the root folders, i.e., C drive, D drive, etc.

4.2.3.9. File Structure of a Mech-Vision Project

The figure below demonstrates a Mech-Vision project’s file structure, which is mainly composed of
the following files:
- An algorithm file (vision_project.vis in the figure): stores the algorithms.

- Camera parameter files (files in the folder Calibration in the figure): store the camera’s intrinsic
and extrinsic parameters and calibration data.

- Project configuration files (depth_background.png, depth_roi.json, roiBoundary.json, etc., in the
figure): describe the setup of the working environment and add restrictions on the project.

The Mech-Vision project files will be automatically generated in the designated project path after
the corresponding operations are performed, so there is no need to create these files manually.
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Calibration
GraspSavedlimg
&| depth_background.png
| depth_roijson

parameter recipe_config.json

M [ [

roiBoundary.json

B vision projectuis

4.2.4. Quick Guide for Robot and Communication Configuration

1. Operations related to robot communication configuration

Before configuration, please confirm the communication mode and protocol used according to
Communication Overview.
o If the communication mode is “Standard Interface” or “Adapter”, please follow this section.
» Select the Robot
= Configure Communication:
= Configure TCP/IP Communication
= Configure Siemens PLC Snap 7 Communication
= Configure PROFINET Communication
» Configure EtherNet/IP Communication
= Configure Modbus TCP Communication
= Configure Adapter Communication
= Configure Mitsubishi MC Communication
= Configure UDP Communication
= Start Interface Service

o If the communication mode is Master-control communication, please refer to the section
Master-control Commmunication.

2. view-tcp-command-set.pdf

4.2.4.1. Configure Adapter Communication

This section introduces how to configure the Adapter communication. Before configuration, please
confirm that you have already selected the robot and entered the communication configuration
interface.
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Communication mode

Interface service type

Adapter
Adapter project directory

Open folder

IP Address
Host IP address ' #

Robot integration

The communication program of the robot side is provided by the user.
For programming, please refer to the specific communication protocol of
the project.

+| Auto enable interface service when opening the solution

1. On the Communication mode interface, set the “Interface service type” parameter to Adapter.
2. Click [8] and select the folder of the Adapter project.

o You need to write the Adapter program first. For details, refer to Adapter Programming
Guide.

3. Inthe IP Address area, enter the IP address and port number of the host.

o o The host IP address and the robot IP address must be on the same subnet.
o The port number should be set to 50000 or larger.

4. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

5. Click the [ Apply ] button.

6. Start the interface service.
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Next, you need to write the robot-side communication program by referring to Standard Interface
Development Manual and load it to the robot.

4.2.4.2. Configure EtherNet/IP Communication

This section introduces how to configure the EtherNet/IP communication. Before configuration,
please confirm that you have already selected the robot and entered the communication
configuration interface.

Communication mode

Interface service type
Standard Interface
Protocol

ETHERMET IP

Advanced Settings ~

Robot integration

Open program folder

» Auto enable interface service when opening the solution

1. On the Communication mode interface, set the “Interface service type” parameter to Standard
Interface, and set the “Protocol” parameter to ETHERNET IP.

2. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

3. Click the [ Apply] button.

4. Start the interface service.
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Next, you need to complete the remaining standard interface configuration according to the
communication object.
4.2.4.3. Configure Modbus TCP Communication

This section introduces how to configure the Modbus TCP communication. Before configuration,
please confirm that you have already selected the robot and entered the communication
configuration interface.

Communication mode

Interface service type

Standard Interface

Protocol
MODEUS TCP Slawve

Byte order Slave ID
CDABE 1

IP Address
Host IP address

Advanced Settings ~

Robot integration

Open program folder

»| Auto enable interface service when opening the solution

1. On the Communication mode interface, complete the following configurations.

a. Set the “Interface service type” parameter to Standard Interface, and set the “Protocol”
parameter to MODUBS TCP Slave.

b. Set the “Byte order” parameter. Set it based on the master device's floating point byte
order. For standard big-endian data, select DCBA, for standard small-endian data, select
ABCD.

c. Set Slave ID according to your needs.
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2. Inthe IP Address area, enter the port number of the host (Modbus TCP slave). The port
number should be set to 50000 or larger.

3. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

4. Click the [ Apply] button.

5. Start the interface service.

Next, you need to complete the remaining standard interface configuration according to the
communication object.

4.2.4.4. Configure PROFINET Communication

This section introduces how to configure the PROFINET communication. Before configuration,
please confirm that you have already selected the robot and entered the communication
configuration interface.

Communication mode

Interface service type
Standard Interface
Protocol

PROFINET-IRT

Advanced Settings ¥

Robot integration

Open program folder

»| Auto enable interface service when opening the solution
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1. On the Communication mode interface, set the “Interface service type” parameter to Standard
Interface, and set the “Protocol” parameter to PROFINET-IRT.

2. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

3. Click the [ Apply] button.

4. Start the interface service.

Next, you need to complete the remaining standard interface configuration according to the
communication object.

4.2.4.5. Configure Siemens PLC Snap 7 Communication

This section introduces how to configure the Siemens programmable logic controller (PLC) Snap 7
communication. Before configuration, please confirm that you have already selected the robot and
entered the communication configuration interface.

Communication mode

Interface service type
Standard Interface
Protocol
Siemens PLC Client
Slot number (2
0
DE number
1
IP Address
PLC IP address

Advanced Settings ~

Robot integration
Open program folder

»| Auto enable interface service when opening the solution
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1. On the Communication mode interface, complete the following configurations.

a. Set the “Interface service type” parameter to Standard Interface, and set the “Protocol”
parameter to Siemens PLC Client.

b. Specify the “Slot number” parameter. Refer to the following table for instructions.

Siemens S7 Series Slot Number
S7-300 2

S7-1200 Oor1
S7-1500 Oor1

Other models 0

c. Specify the “DB number” parameter.

2. Inthe IP Address area, enter the PLC IP address. The PLC IP address and the IPC IP address
must be on the same subnet.

3. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

4. Click the [ Apply] button.

5. Start the interface service.

Next, you need to complete the remaining standard interface configuration according to the
communication object.

4.2.4.6. Configure TCP/IP Communication

This guide introduces how to configure the TCP/IP communication. Before configuration, please
confirm that you have already selected the robot and entered the communication configuration
interface.
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Communication mode

Interface service type

Standard Interface
Protocol

TCP Server

IP Address
Host IP address

Advanced Settings ¥

Robot integration
Open program folder

+| Auto enable interface service when opening the solution

1. On the Communication mode interface, set the “Interface service type” parameter to Standard
Interface, set the “Protocol” parameter to TCP Server, and set the data transmission format
according to the following table.

Robot Brand Data Transmission Format
ABB HEX (Little-endian)

FANUC HEX (Big-endian)

KUKA HEX (Little-endian)
Yaskawa ASCII

Kawasaki ASCII

UR ASCII

™ ASCII

ELITE ASCII
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Robot Brand Data Transmission Format
JAKA ASCII
ROKAE ASCII
Others You need to write the robot-side

communication program. You can determine
the data transmission format according to the
support for HEX and ASCII.

In the IP Address area, enter the port number of the host.
(i ) The port number should be set to 50000 or larger.

(Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

Click the [ Apply ] button.

5. Start the interface service.

Next, you need to complete the following operations according to the selected robot.

If a listed robot is selected, complete the subsequent operations by referring to the
corresponding documents in the following table.

Robot Brand Reference Document

ABB ABB Standard Interface Configuration
FANUC FANUC Standard Interface Configuration
FANUC CRX CRX Plugin Installation and Configuration
Kawasaki Kawasaki Standard Interface Configuration
KUKA KUKA Standard Interface Configuration
YASKAWA YASKAWA Standard Interface Configuration
UR URCap Plugin Installation and Configuration
™ TM Standard Interface Configuration

LITE ELITE Standard Interface Configuration
JAKA JAKA Standard Interface Configuration

- If alisted robot other than the preceding robot brands is selected, you need to write the robot-

side communication program by referring to Standard Interface Development Manual. For
calibration, you can perform automatic calibration by referring to the Master-Control
communication setup guide to the specific robot.

+ If a custom robot is selected, you need to write the robot-side communication program by

4.2

referring to Standard Interface Development Manual. For calibration, you can perform manual
calibration.

.4.7. Configure Mitsubishi MC Communication

This section introduces how to configure the Mitsubishi MC communication. Before configuration,
please confirm that you have already selected the robot and entered the communication
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configuration interface.

Communication mode

Interface service type

Standard Interface
Protocol
Mitsubishi MC Client
Frame Register(D] Base Address
4000
IP Address

PLC IP address

Advanced Settings ~

Robot integration
Open program folder

» Auto enable interface service when opening the solution

1. On the Communication mode interface, complete the following configurations.

a. Set the “Interface service type” parameter to Standard Interface, and set the “Protocol”
parameter to Mitsubishi MC Client.

b. Inthe Frame drop-down list, select 3E for most cases.
c. Set the Register(D) Base Address.

o The struct types used for communication occupy a total of 728 D registers.

2. Inthe IP Address areg, fill in the IP address and port number of the PLC. The port number
should be set to 50000 or larger.

3. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

4. Click the [ Apply] button.
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Next, you need to complete the remaining standard interface configuration according to the
communication object.

4.2.4.8. Configure UDP Communication

This section introduces how to configure the UDP communication. Before configuration, please
confirm that you have already selected the robot and entered the communication configuration

interface.

Communication mode

Interface service type

Standard Interface

Protocol

LIDP Server

IP Address
Host IP address

Advanced Settings ~

Robot integration

Open program folder

+| Auto enable interface service when opening the solution

1. On the Communication mode interface, set the “Interface service type” parameter to Standard
Interface, set the “Protocol” parameter to UDP Server, and set the data transmission format
based on support for HEX and ASCII.

2. Inthe IP Address area, enter the port number of the host.

(3]

The port number should be set to 50000 or larger.
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3. (Optional) Select Auto enable interface service when opening the solution. When the solution
is opened, you do not need to start the interface service manually.

4. Click the [ Apply] button.

5. Start the interface service.

Next, you need to complete the remaining standard interface configuration according to the
communication object.

4.2.4.9. Obtain the Robot Programs

This section introduces how to obtain the robot programs.

After selecting a robot, in Communication Option window, click [ Open program folder ] to open the
folder storing the robot communication program and example program.

Communication Option
Interface Type

Standard Interface

Protocol

TCP Senver *  HEX-Little endian
Advanced Settings ~

IP Address
Host [P address

Robot Integration

Open program folder

Auto enable interface service when opening solution
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4.2.4.10. Select the Robot
This section introduces how to select a robot.

1. Click [Robot Communication Configuration ] on the toolbar of Mech-Vision.

2. Select the robot.

o Select a listed robot
= Click the Select robot drop-down box, select Listed robot, and then click the [ Select
robot model ] button.

Select robot

Listed robot

Select robot model

= |nthe Brand drop-down box, select the robot brand. All robot models of this brand will
be displayed on the right panel.

ABB_CRB_15000_5_0_95 ABB_IRB_120_3 0.6

ABB_IRB_1300.11.0 9
1kg

Payl

= Specify the Axes, Payload, and Reach parameters to narrow down the
(,) scope of robot models.
= |nthe search box, enter the robot brand and model to filter the robot. Click

-
the button to clear the text in the search box.
If you fail to find the required robot model in the robot library, close this window.
Please import the robot model first and then perform this step again.

= Hover the cursor over the robot model to select, and click the [ Select] button when the
frame turns grey-white to close the window.

= Click the [ Next] button to enter the Communication Option interface.
o Select a custom robot (for example, truss robot)
= Click the Select robot drop-down box and select Custom robot.
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Select robot

Listed robot

Listed robot
Custom robot

Mot use robot

= Specify the Robot Euler angle convention parameter.

= Select the robot coordinate system.

Select robot
Custom robot

Robot Euler angle convention =Y ROTATED) =

Select robot coordinate system

Left-handed Right-handed

= Click the [ Next] button to enter the Communication Option interface.
o Select not to use robot (in scenarios where no robots are used, such as measuring)

= Click the Select robot drop-down box and select Not use robot.

Select robot

Mot use robot

Custom robot

Mot use robot

= Click the [ Next] button to enter the Adapter Communication Option interface.

) If you select Not use robot, only the Adapter communication option can be used.
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4.2.4.11. Start Interface Service
This section introduces how to start the interface service.

In the main window of Mech-Vision, click the “Robot Communication Configuration” switch on the
toolbar. The interface service will be enabled as shown in the following figure.

I Robot Communication Config . @

If the interface service is started successfully, log “Start xxx interface” will be displayed under the
Console tab of the Mech-Vision log panel.

If the interface service fails to be started, please check the robot communication configuration.

4.2.4.12. Guide for Robot Library Tools

This section introduces procedures for using “Robot Library Tools”.
Import Robot

You can export the robot model file (MROB file) from Mech-Viz menu bar > Tools > Robot
o Library Tools > Export Current Robot, or from Mech-Vision menu bar > Robot and
Communication > Robot Library Tools > Export Current Robot.
You can use either of the following methods to import the robot model.

+ Method 1
o Drag the robot model file in MROB format to the Mech-Vision software window.

o A "Successfully imported robot(s)” message will appear. Click [ OK] in the pop-up window.

ssfully imported robot(s)

+ Method 2
o In Mech-Vision's menu bar, select Toolkit > Robot Library Tools > Import Robot.

o Select the MROB file in the Select Robot Packages window, and click [ Open .
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> robot

2 #f robot FEE

=~ @ @
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D ur_10e.mrob 2022/12/26 14:59 MROB 3zf% 3,561 KB
STAEE(N): | ur_10e.mrob v| mrob (mrab) v
£17(0) s

o A "Successfully imported robot(s)” message will appear. Click [ OK ] in the pop-up window

sfully imported robot(s):

Export Current Robot

Follow these steps to export the current robot model.
1. In Mech-Vision's menu bar, select Toolkit > Robot Library Tools > Export Robot.

2. Select a folder to which the robot model file will be exported in the pop-up window, and click
[ Select Folder].

> robot »

O ¥E robot FiEE

i
E
i
4
©

EHES “2

Fh
UR 2022/12/26 16:25 ST

IzfgE UR

FEE HiE

3. A"Successfully exported robot(s)” message will appear. Click [ OK ] in the pop-up window.
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Q If the robot model is exported successfully, a MROB file will appear in the specified folder.

4.2.5. Basic Procedures for Using Steps

This chapter introduces you to basic procedures of using Steps.
Search/Add/Delete Steps

Create/Delete Connections

Input/Output of Steps

Statuses of Steps

Run Steps and View Outputs

Introduction to Step Comments

A Procedure groups the Steps whose functions are closely related and achieve a specific purpose
concertedly in the project.

Please check the sections below to learn about using Procedures.
Basic Features of Procedures
Modify Parameters of Procedures

Create your own Procedure

4.2.5.1. Search/Add/Delete Steps

The “Capture images from camera” Step is used as an example.

Search for a Step

- Enter the name of the step directly in the search box of the step library (or enter a keyword in
the name).

Step Library
capture images from camera

¥ Capture from Camera

Q" Capture Images from Camera

- Click the corresponding Step category to expand the hierarchical list.
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Camera

Camera 20

Capture Images from Camera

Add a Step

Press and hold the left mouse button to select a Step, drag it to any position in the graphical
programming workspace and release it.

PRn W @ ) Debug Output
Caplure Images from Camera (1)

<Image/Depth> <Image/Color> <Cloud(XYZ)>  <Cloud(XYZ-RGB)>
Camera Depth Image ~ Camera Color Image | Point Cloud  Colored Point Cloud

o You can add Steps only after you have created a new project or opened an existing project.

Delete a Step

* Left-click a Step and press Delete on the keyboard.

- Right-click a Step and click [ Delete ] in the context menu.

Capture Images from Camera (1)

<Image/Depth> <Image/Color> =<Cloud{(XYZ)>
Camera Depth Image  Camera Color Image  Point Cloud opy Ctrl+C

Ctrl+X

Del

Ctrl+F

Alt+Shift+F

Ctrl+A

creenshot

4.2.5.2. Create/Delete Connections

Create a Connection

Hover over the output port of a Step, and then hold down the left mouse button and move the
mouse to the input port of a succeeding Step to create a connection.

An output port can be connected to multiple input ports, but an input port can only be connected to
one output port.
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port of Cloud(XYZ-Normal) can only be connected to the input port of Cloud(XYZ-Normal).

Connections can only be created among ports of the same data type. For example, the output
o Ports of different data types can't be connected.

Delete a Connection

- After clicking the connection with the left mouse button, the connection will be highlighted.
Press Delete on the keyboard to delete it.

- After right-clicking the connection, the connection will be highlighted, and a context menu bar
will pop up. Then, click [ Delete ].
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4.2.5.3. Input/Output of Steps

You can view the input/output data type of a Step by hovering the mouse over the corresponding
port. The input/output ports of each step are on the top or at the bottom of the Step, as shown
below, where 1 represents the input ports, and 2 the output ports.

Move the mouse over the port and a detailed description of the data type as shown below will
appear.
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4.2.5.4. Statuses of Steps

Once the Steps are run, you can view the statuses of Steps by the frame color.

Status Illustration

Regular
Selected
Warning

Error

4.2.5.5. Run Steps and View Outputs
The successful functioning of an individual Step is the basis of the successful functioning of the

entire project. This section will show you how to run the Step, and use the debug output feature to
check the performance of the Step.
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Run the Step

« Clicking [Run] in the Project toolbar will run the entire project.

P> Run

+ Clicking @ on a Step will run the project down from the current Step.

Capture Images from Camera (1)

<Image/Depth> =Image/Color= <Cloud(X¥Z)> <=Cloud(XYZ-RGB)=
Camera Depth Image  Camera Color Image ~ Point Cloud Colored Point Cloud

» Click || to run the current Step independently.

Capture Images from Camera (1)

=Image/Depth= =Image/Color= =Cloud(X¥Z)= =Cloud(XYZ-RGB)=
Camera Depth Image  Camera Colorimage  Point Cloud Colared Point Cloud

Debug Output

As an integral part of Mech-Vision, the debug output panel is where you can view the visualized

output.

When debugging the project, the debug output feature enables users to visualize the output of the

current Step.

Interface Introduction

The debug output panel is located in the upper right corner of the main interface, as shown below.
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Debug Qutput

Y

Mo debug output to display

Please do one of the followings:
Enable "Debug Qutp 1d run the proje the debug outputs of all Steps.
Run the project, left nddragona s ngle Step Execution™ button, and click
sualize Qutput™ to see the Step’s output.

Interface description:

- The data type of the output will be shown in 1.
+ Click 2 will make the panel pop up and turn it into an individual window.

+ The visualized output will be displayed in 3.

Instructions

View the output of an individual Step in debug mode

Switch on Debug Output (7). Click BB on the Step that you would like to view the output. Anicon as
suggests that the visualize output feature is enabled. Click [ Run] in the Project tool bar. Then
click the Step and you will see the visualized output in the debug output panel.

th= <Image/Color>

<Clou

<Clou <String>
amera Depth Image |~ Camera ColorImage | PointCloud | Colored Point Cloud  Color Image Path

View outputs of multiple executions of an individual Step in debug mode

To view the visualized outputs of multiple executions of a specified Step, please select the Step
first and then click [ to pop up the individual debug output window. Click [ Run] in the Project tool
bar and you can view the visualized outputs of multiple executions of the selected Step in the
individual debug output window (4).
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=Cloud0YZ-Normal) [ > = <NumberList->
Interected Clouds Confidences

tto center.

Point count: 222394
Press r/Rto reset camera view point to center.

If you need to view multiple visualized outputs of multiple Steps, please follow the above
instruction and open multiple individual debug output windows.

View outputs of an individual Step from other perspectives in debug mode

You can drag the 3D image in the individual debug output window to view the visualized outputs of
an individual Step from other perspectives. Click [ Run] in the Project tool bar and you can view the
visualized outputs from your specified perspective.

=Cloud(X¥Z-Normal)=
Point Cloud

Extract 3D Points in 30 ROI (1)

=Cloud(X¥Z-Normal)=
Point Cloud in ROI

l

. Point count: 328902

Press 1/R to reset camera view point to center.

View outputs of different Steps in a Procedure

When a Procedure contains Steps whose debug output features are enabled, you can check
visualized outputs of different Steps in the Procedure.

Click the Procedure, select the Step you would like to view the visualized output in the drop-down
list (2) in the debug output panel.

Debug Qutput - 3DCoarseMatchingV2 (1]

0 3DCoarseMatchingv2_1
Debug Output (@ e —

ase list 2 size:
<Cloud(XYZ-Normal)> Pose List 2: size: 1

Unnamed

Procedure (3DMatching) Pose List 4: size:
Pose List 5: size:

i

<Cloud(XYZ-Normal) [ > . .
Filtered Object Point Clouds Pose List 7: size: 1

X-Axis: red; Y-Axis: green; Z-Axis: blue

Press 1/R to reset camera view point to center.

Click [Run] in the Project tool bar and you can view the visualized outputs of different Steps in the
Procedure.
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Pose List 2: size: 1

Pose List 4: size: 1

Pose List 5: size: 1
=Cloud(XYZ-Normal)=

Pose List 7: size: 1

Procedure (3DMatching) . . .
X-Axis: red; Y-Axis: green; Z-Axis: blue

Tir

=Cloud(XYZ-Normal) [ > Press /R to reset camera view point to center.
Filtered Object Point Clouds

X-Axis: red; Y-Axis: green; Z-Axis: blue

Press 1/R to reset camera view point to center.

View the output of an individual Step in non-debug mode

When the Debug Output is not switched on, you can still check the visualized output of the Step.
The two methods are shown below.

- Click | and drag in any direction, select [ Visualize Output] and release the mouse button.
Then you can view the visualized output in the debug output panel.

<Image/ColonMask[]>  =Cloud(XYZ-Normal)> =St “<NumberList->
Mask Images Original Peint Cloud ‘Confidence:

int Cloud (1)

<Cloud(XYZ-Normal) [ > <5t <NumberList->
Interected Clouds Lat ‘Confidences
Point count: 224540

Press 1/R to resef camera view point o center.

int Cloud and Filter It 3) %2

Point Cloud With Normals
s

—

v
<Cloud(XYZ-Normal)>
d

Point count: 382854
Press /R to reset camera view point to center.

<Cloud(XYZ-Normal)>
Foint Cloud in ROI

Q Please run the entire project or the single Step before viewing the visualized output.
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4.2.5.6. Introduction to Step Comments

You can add a comment or description to a certain Step or Procedure in the project

How to Add Comments

1. Right-click the Step or Procedure to which you want to add a comment, and select Comment
Selected Step.

<Cloud(XYZ-Normal) [] =
Original Point Clouds

Transform Point Clouds (1%

Time: 4ms Copy Cirl+C
Ctrl+X
<Cloud(XYZ-Normal)

Transformed Point Clc o

Ctrl+F
B Format Alt+Shift+F
Register as Vision Service

Ctrl+A

El save Flow Data

/_ Comment Selected Step
*7 Calculate Project Hash

Execution Flags of All St

@® Show Type And Name Ctrl+Alt+A

2. Enter your comment in the pop-up window, and then click on anywhere in Mech-Vision to close
the window.
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Please enter description below (10 meanings, goal of algorithms etc.)

This is an example comment |

How to Modify the Comment
Click [l

<Cloud(XYZ-Normal) [] = = <Poselist->
Original Point Clouds Reference Pose

Transform Point Clouds (1) = ¥

{:._..:}

e

This Is an example comment.

<Cloud(XYZ-Normal) [] >
Transformed Point Clouds

How to View the Comment

Click the Step Comment List tab in the lower right to view all the comments in the current project.
If there is no such tab, please check if View » Step Comment List is checked.

Click an comment, and the Step or Procedure to which the comment is added will be centered and
flash in the Graphical Programming Workspace.
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<Cloud(XYZ-Normal) [] >
Original Point Clouds

Transform Point Clouds (1) ~ $

Time: 4ms
This is an example comment

<Cloud(XYZ-Normal) [] >
Transformed Point Clouds

4.2.5.7. Basic Features of Procedures

Vision System Software Manual

Step Comment
] T

This is an example comment

Step Paramet... _Project Assist.. Sfep Quick ... Hist.. Step Comment ...

Before you get to know the Procedures, you should know Basic Features of Procedures.

The following instructions are based on the Procedure Point Cloud Preprocessing. Please create a

new project first.

+ How to add a Procedure in the project?

Go to Custom » Point Cloud Preprocessing in the Step library, and drag the Procedure to the

graphical programming workspace.

+ How to view the Steps in a Procedure?

<ImagefDepth= <Image/Golor-»
2 DepthImage | Car

600V
PointCloudin ROl Colored Point Cloud

Double-click the Procedure or right-click the Procedure and select [ Navigate Down ] (shortcut key:

PgDown ) to view the Steps.

<Image/Depth> <Ilmage/Color->
Camera DepthImage Camera Color Image

Point Cloud Preprocessing (1) ‘ 5 | ¥

Preprocess the original pointclo... /..

<Cloud(XYZ-Normal)>  <Cloud(XYZ-RGB)>
Point Cloud in ROI Colored Point Cloud

© 2024 Mech-Mind Robotics Technologies Ltd.
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+ How to go back to view the whole Procedure?

Right-click in any space in the graphical programming workspace, and select [ Navigate Up ]
(shortcut key: PgUp).

1 2

I

<Image/Depth> <Image/Color->
Camera Depth Inage  Camera Color Image

From Depth Map to Point Cloud (2)
U Navigate Up

1 4
=t
e

Switch to Simplified Mode

<Cloud(XYZ)> <Cloud (XYZ-RGB)> a

Point Cloud Colored Point Cloud

<Cloud(XYZ)>

Point Cloud

) ) . Q. Find Step Ctrl+F

Calc Normals of Point Cloud and Filter It (2) ~ ¥
H Format Alt+Shift+F

o Select All Ctrl+A

e Save Screenshot
<Cloud(XYZ-Normal)> o
Point Cloud With Normals Z

<Cloud(XYZ-Normal)> %
Point Cloud
Set Execution Flags of All Steps  »

Extract 3D Points in 3D ROI(2) Set Steps Ports Visible 3

<Cloud(XYZ-Normal)> | <PoseList> <Cloud(XYZ-RGB)>
Point Cloud in ROl Flange Poses Visualization Cloud

l

1

4.2.5.8. Modify Parameters of Procedures

You can modify the parameters of the Procedures according to different scenarios. The following
instructions are based on the Procedure Point Cloud Preprocessing and mainly covers the
following topics:

+ Delete and Add Parameters

+ Customize the Display Information of the Parameter

Right-click the Point Cloud Preprocessing and select [ Edit Procedure Parameters ] in the context
menu.

<Im age/Depth> <lmage/Color->
Camera Depih Image Camera ColorImage

Point Cloud Preprocessing (1) = . \
: # Edit Procedure Parameters

Preprocess the original point clo... /. save Procedure as Template

<Cloud{XYZ-Normal)> <Cloud(XYZ-RGB)>
Point Cloud in ROI Colored Point Cloud

Delete and Add Parameters

The parameters in the Parameter List correspond with those in the Step Parameter panel, as
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shown below.

Parameter List Step Parameters

Delete a Parameter

Click the parameter that you want to delete and then click Izl or right-click the parameter and
select [ Delete ] in the context menu to delete the parameter. Click [ Yes ] in the pop-up window.

T

I minPointNum_Extract 30 Points in 30 ROI (1) 1 Delete Del

Click [ Apply] to save the setting, and then you will find that the parameter in the Step Parameter
panel has disappeared.

Add a Parameter

In the pop-up Edit Procedure Parameters window, click [ +] to open the Add a New Parameter
window.
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Parameter List Step Parameters

+ o
Enalish

B Add a New Parameter x

an inte f the Pro
terinfo for tf

Parameters in step

[ Expand procedure

Select step outputtype Al v
Calc Normals Cloud and Filter It...

Extr Poin 1)
From th Map to Point Cloud (1)

Cancel

Select a Step and its parameter in the window. As shown below, the Step Extract 3D Points in 3D
ROl and its 3D ROI Settings parameter is selected. Click [ OK] to save settings.

3D ROl Name

Extract 3D Points in 3D ROI (1)

The selected parameter will appear in the Parameter List. Click [ Apply] to apply the settings.
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. roiBoundaryPath Extract 3D Points in 3D ROI (2)

Then you can see the newly added parameter in the Step Parameter panel.

¢ Setting tool ofthe region of interest (ROI).
3D ROI Name -

Json

Customize the Display Information of the Parameter

Open the Edit Procedure Parameters window as mentioned before. Click the parameter in the
Parameter List and go to the Parameter Info Customization tab.

You can edit the Display Name, Value Tooltip, and Key Tooltip. Click [ Apply] to save the editing.
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Parameter Info Customization

ckgroundByDepth_ From Depth Map to Paint Cloud (2)

nd with depth map

Value Tooltip

Key Tooltip

The displayed parameter information after being modified is shown below.

Remove Background

1 -
Remove background with depth map
i

Remaove Background

. Check to remave background with using depth maps.

4.2.5.9. Create your own Procedure

Customizing Procedures is supported.
This section will show you how to package Steps to create a customized Procedure Point Cloud
Processing. The Steps From Depth Map to Point Cloud, Calc Normals of Point Cloud and Filter It,

and Extract 3D Points in 3D ROl are needed to create the Procedure, and the packaging should be
completed with Procedure.

Add Steps

1. Locate [vision-steps:procedure::vision-procedure] in the Step library and drag it to the graphical
programming workspace, as shown below.
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Step Library

procedure

Meta

Tools

Procedure

2. Click [vision-steps:procedure::vision-procedure] to enter the Step level and then connect the
Steps as shown below.

<Image/Depth> <Image/Color->
Camera Depth Image  Camera Color Image

From Depth Map to Point Cloud (1)

<Cloud(XYZ)> <Cloud(XYZ-RGB)>
Point Cloud Colored Point Cloud

<Cloud(XYZ)>
Point Cloud

Calc Normals of Point Cloud and Filter It (1)

<Cloud(XYZ-Normal)>
Point Cloud With Normals

<Cloud(XYZ-Normal)>
Point Cloud

Extract 3D Points in 3D ROI (1)

<Cloud(XYZ-Normal)> | <PoselList> <Cloud(XYZ-RGB)>
Point Cloud in ROI Flange Poses Visualization Cloud

Set the Input and Output of the Procedure
* Input:
Double-click the input port of [vision-steps:from-depth-map-to-point-cloud::from-depth-map-to-

point-cloud]. A short line with the number indicates that the port will be used as the input port of
the Procedure.
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1

l

<Image/Depth> <Image/Color->
Camera Depth Image =~ Camera Color Image

<Image/Depth> <Image/Color->
From Depth Map to Point Cloud Camera Depth Image ~ Camera Color Image
Procedure (1)
e

The sequence of clicking the port decides the sequence of the port being displayed on the
Procedure.

The figure above shows the layout of the input ports of the Procedure when Camera Depth Image

is clicked before Camera Color Image, while the figure below shows the layout when Camera Color
Image is clicked before Camera Depth Image.

2

l

<Image/Depth> <Image/Color->
Camera DepthImage  Camera Color Image
<Image/Color-> <Image/Depth>
From Depth Map to Point Cloud (1) = ¥ Camera Colorimage  Camera Depth Image

Procedure (1)

Nt
[ N

Click the number on the port, press Delete or right-click the number and select [ Delete] in the
context menu to delete the port.

+ Qutput:

The method to set the output ports is the same as that of the input ports.
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<lmage/Depth> <Image/Color-=
Camera Depth Image  Camera Color Image

From Depth Map to Point Cloud (1)

=Cloud(XYZ)> <Cloud(XYZ-RGB)>
Point Cloud Colored Point Cloud

<Cloud(XYZ)>
Point Cloud

Calc Nom als of Point Cloud and Filter It (1) ~

¥
ot
[
<Cloud(XYZ-Normal)>
Point Cloud With Normals

<Cloud(XYZ-Norm al)>
Point Cloud

Extract 3D Points in 3D ROI (1)

<Cloud(XYZ-Normal)> | <Poselist> <Cloud(XYZ-RGB)>
Point Cloud in ROI Flange Poses  Visualization Cloud

Edit Procedure Parameters

After creating a Procedure, you can only change the name of it, as shown below.

Step Parameters
Step Name Procedure_1

<Image/Color-> <Image/Depth>
Camera Colorimage  Camera Depth Image

Procedure (1)

<Cloud(XYZ-RGB)> <Cloud (XYZ-Norm al)>
Colored PointCloud  Point Cloud in ROI

To facilitate adjusting the parameters of the Procedure, you can select some key parameters of

the Steps as the parameters of the Procedure.
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1. Right-click the Procedure and select [ Edit Procedure Parameters ] in the context menu.

<Image/Color-> <Image/Depth>
Camera Colorimage Camera Depth Image

Procedure (1) ~ 1}

. & Edit Procedure Parameters
Save Procedure as Templats

<Cloud(XYZ-RGB)> <Cloud (XYZ-Normal)>
Colored PointCloud  Point Cloud in ROI

2. In the pop-up Edit Procedure Parameters window, click [ +] to open the Add a New Parameter

window.

B Add a New Parameter x

Step/Procedure Parameter

Select step Parameters in step
O Expand procedure

Select step output type All -

Cancel

There are three Procedure parameters:

+ Step/Procedure Parameter (the one used here)

+ Custom Mapped Parameter

+ Custom Recipe Parameter

1. Select a Step and its parameter in the window. As shown below, the Step [vision-
steps:extract-3d-points-in-3d-roi::extract-3d-points-in-3d-roi] and its 3D ROI Settings
parameter is selected. Click [ OK] to save settings.

o

You can select multiple parameters according to actual needs.
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¥ 3D ROI Settings
3D ROl Name

Extract 3D Points in 3D ROI (1)

2. Now you can see the selected parameter in the Parameter List. Click [ Apply] to apply the
changes.

.* roiBoundaryPath_Extract 3D Po

3. The selected parameter will appear in the Step Parameters window.

Step Parameters
Step Name Procedure_1
v Extract 3D Points in 3D ROI (Extract 3D Points in 3D ROI_1)
# Setting tool of the region of interest (ROI).

3D ROI Name
3d_ro

Save the Procedure

You can add the customized Procedure to the Custom directory in the Step library.

1. Right-click the Procedure and select [ Save Procedure as Template ] in the context menu.
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<Image/Color-» <Image/Depth>
Camera Colorimage Camera Depth Image

Procedure (1) = N dit Procedure Parameters

Save Procedure as Template

b Comment Selected Step
<Cloud(XYZ-RGB)> <Cloud (X¥Z-Normal)>

Colored PointCloud  Point Cloud in ROI

2. Name the Procedure template.

Save Current Procedure as ... X

Flease input template name (in English):

Point Cloud Processing|

OK Cancel

The name of the customized Procedure template cannot be the same as other existing
Step/Procedure names.

3. Click [ OK] to save the name. Then you can see the newly added Procedure in the Custom
directory in the Step library.

I- Y Point Cloud Processing

To delete a customized Procedure, you can select the Procedure and press Delete, or right-click
the Procedure and select [ Delete] in the context menu.

:- - Point Cloud Processing

T Delete Del

© 2024 Mech-Mind Robotics Technologies Ltd. 102



i o/

MECH MIND Vision System Software Manual

+ custom-mapped-parameter.pdf

+ custom-recipe-parameter.pdf

4.3. Step Reference Guide

This chapter provides the reference guide for using Steps and Procedures in Mech-Vision.

Step Reference

- 2d-matching.pdf

+ Convert Poses 2D to 3D According to Orthographic Projection
+ 2D Shape Matching

» 3D Coarse Matching (Multiple Models)

+ 3D Coarse Matching V2

+ 3D Coarse Matching

+ 3D Fine Matching Lite

- 3D Fine Matching (Multiple Models)

+ 3D Fine Matching

-+ 3D Workpiece Recognition

+ Accept All

+ Add Labels to Poses

+ Adjust Inaccurate Poses Caused by Camera Distortion
- Adjust Poses by Offsets

+ Adjust Poses by Tilt

+ Adjust Targets to Get Correct Path

+ Move Poses to Point Cloud Surfaces

+ Change Circular Motion Direction of Path
+ Allocator

+ Apply Masks to Image

+ Apply Masks to Point Cloud

» Extract 2D Path Function

+ Background Subtraction

+ Image Thresholding

+ Blob Analysis

+ Boolean List Logical Operation

+ Bridge

+ Calc Absolute Values

+ Calc Angles between Vector3Ds

« Calc Areas of Masks
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+ Calc Box Dimensions
« Calc Vector3D Cross Products
+ Calc Diagonal Lengths

 Calc Diameter and Thickness

- Calc Distance between Two Poses along Specified Direction

+ Calc Distances between Poses

+ Calc Vector3D Dot Products

+ Calc Edge Point Cloud Normals

+ Calc Flatness Error

+ Calc Histogram

» Calc Included Angles between Specified Axes of Poses
+ Calc Intersection between Two Line Segments

+ Calc Intersections between Line Segment and Circle
+ Calc Point Cloud Spans along Axes

+ Calc Lengths of Vector3Ds

+ Calc Mask Distances

+ Calc Mask Spans on Given Lines

+ Calc Mean Gray Value

- Calc Midpoint of Specified Side of Rectangle

+ Calc Minimum Bounding Rectangles Of Masks

+ Calc Normalized Vector3Ds

+ Calc Normals and Estimate Edges of Point Cloud
+ Calc Normals of Point Cloud and Filter It

+ Calc Parallelism Error

+ Calc Pixel Sizes at Specified Heights

» Calc Plane Width

+ Calc Point Cloud Curvatures

» Calc Poses and Dimensions from Planar Point Clouds
- calc-poses-and-dimensions-of-rectangles.pdf

» Calc Profile by Sampling

» Calc Profile

- Calc Projection Length along Reference Direction
- Calc 2D Poses of Rectangles

+ Calc Results by Python

+ Calc Specified Property of Point Clouds

+ Calc Calibration Matrix of Structured Light Sensor

» Calc Center Points of Non-Zero Regions
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+ Calc Cylinder Poses

- calculate-calib-board-pose.pdf

+ Caliper Tool

+ Camera 2D

- Capture Images from Camera

+ Classify Point Clouds by Dimensions

» Correct Point Cloud Distortion

« Filter Point Cloud by Model and Poses

+ Cloud Num Limit

» Cloud Processing (GPU)

+ Scale Point Cloud

» Smooth Point Cloud and Estimate Normals

+ Extract Point Cloud in 3D Box

+ From CloudXYZ To CloudNormal

» Cluster Point Clouds and Output Eligible Point Clouds
+ Draw Coherent Lines

+ Collect Poses in 3D ROI

+ Compare Two Depth Maps

« Compare Values

+ Compose New Poses by Combining Parts of Input Poses
+ Compose Poses from Quaternions and Translation Vectors
+ Compose Quaternions from Axes and Angles

+ Compose Quaternions from Two Axes (Right Hand Rule)
« Compose Vector3Ds from Numbers

+ Control Light Source

+ Convert 2D Poses to 3D Poses

+ Convert Data Type

+ Convert Lengths Pixel-Wise to Physical

+ Convert 2D Points to 3D Points

+ Convert Circles To 2D Poses

+ Convert Color Space

+ Copy Images

- count-boxes.pdf

+ Count Elements in Specified Dimension in Data List

+ Count 3D Points

+ Count Color Info

+ Create Object Model
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+ Crop Image

+ Decompose Object Dimensions

+ Decompose Poses to Quaternions and Translations
+ Decompose Quaternions to X- Y- Z- Axes
+ Decompose Vector3D to Numbers

+ deep-learning-inference.pdf

+ Deep Learning Model Package Inference
+ Deep Learning Result Parser

+ Depth Clustering along Scan Lines

+ Depth Encoding

+ Detect and Measure Circle

+ Detect and Measure Line

+ Detect and Measure Oblong Hole

- Detect Bin (Four Sides)

» Detect Bin (Max Inscribed Rect)

+ Detect Bin (Max Inscribed Rect) V2

» Detect Bin (Two Sides)

+ Detect Circle Centers

+ Detect Corners

+ Detect Edges

+ detect-fiducial-markers.pdf

+ Detect Inscribed Circles

+ Detect Line Segments

» Detect N Largest Rectangles in Mask

+ Detect Occluded Objects

- Detect Shape Feature of Region

+ Detect Vertex

+ Determine Pixel Sizes

+ Dichotomize Values by Threshold

+ Divide Point Cloud into Smaller Parts Evenly
+ Down-Sample Point Cloud

» Draw Min Circumscribed Rectangles of Masks
- draw-polygon-vertices.pdf

+ Easy Frame Transformation

+ Easy Create Index List

- Easy Create Number List

+ Easy Create Poses
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+ Easy Create Quaternions

+ Easy Create String List

+ Easy Create Vector3Ds

- Easy Point Poses to Reference Position

+ Estimate Point Cloud Edges by 2D Method

+ Estimate Point Cloud Edges by 3D Method

+ Evaluate Image Clarity

+ Evaluate Results by HDevENngine

+ Evaluate Results by JavaScript Engine

+ Evaluate Depth Map Fluctuation

- evaluate-2d-poses.pdf

« External Interface

+ Extract 3D Points in Cuboid

+ Extract 3D Points in Cylinder

+ Extract 3D Points in 3D ROI

+ Extract Empty Regions in Depth Map within 3D ROI
+ Fill Holes

- Filter by Labels

- Filter Masks by Poses

+ Remove Poses outside Bin

- Filter

+ Find Corners

+ Find Correspondence between Poses and Offsets
+ Find Hole 2D

- Find 2D Contour at Specified Inner-Outer Level
- Fit Circle

» Fit Line

* Flip Poses’ Axes

+ From Actual Dimensions to Dimensions in Pixels
+ From Cloud (XYZ-Normal) to Cloud (XYZ-RGB)
» From Cloud (XYZ-RGB) to Color Image

+ From Depth Map to Point Cloud

+ Convert Disparity Image to Depth Map

+ From NumberList to Size3DList

+ From Numbers to Variants

+ From PoselList to Matrix4D

« From Poselist to PoselLists
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+ Convert Quaternions to Euler Angles in Poses
 From Shape2DList to Pose2DList

+ From Variant to Variants

+ From Variants to Labels

» From Variants to Numbers

+ From Variants to Variant

+ From 3D Poses to 2D Poses

+ Generate Cloud Wall

+ Generate Cylinder Point Cloud Model

+ Generate Discrete Poses Revolving around Reference Pose
+ Generate Pick Points

+ Generate Point Cloud Model

+ Generate Ring Point Cloud

+ Generate Pose/Offset

+ Generate Rect Path

- generate-rectangle-candidates.pdf

* generate-rectangular-edge-templates-of-specified-sizes.pdf
+ Generate Spiral Path

+ Generate Test Image

+ Generate Test Point Cloud

+ Generate Path from Contour

+ Generate Path Given Depth Map

+ Generate Zigzag Path

» Get First Image from Image List

+ Get Flange Pose List

- Get Highest Layer Regions in Depth Map
+ Get Highest Layer Clouds

+ Get Highest-Layer Points

+ Get Highest-Layer Poses

+ Get Highest Score Result

» Filter Ring Point Cloud List

+ Group Data

+ Group 2D Poses

+ Histogram Matcher

+ Image Brightness and Color Balancer

+ Image Filtering

+ Adjust Image
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+ Insert End Target and Send Motion Params
« Invalidate Depth Pixels outside 3D ROI

* Invert Poses

- Get Inverses of Quaternions

- Compare Z Values of Poses with Threshold
» Join Labels

+ Keep Poses Distributed in Regular Polygon
+ Label Mapping

+ 3D Laser Profiler

+ load-2d-templates.pdf

+ Load Targets in Path and Apply Affine Transform
» Load 2D Path

+ Locate Calibration Spheres

+ Point Poses to Reference Positions

+ Make Template

+ Map Depth to RGB

+ Map to Multiple Pick Points

+ Extract Image Regions by Mask

+ Mask Clustering

» Filter Masks

+ Mask Gridding

+ Mask Logical Operation

+ Measure Angles Segments to Segments

+ Measure Circles

+ Measure Distances Circles to Circles

+ Measure Distances Circles to Segments

+ Measure Distances Points to Circles

+ Measure Distances Points to Points

+ Measure Distances Points to Segments

+ Measure Distances Segments to Segments
+ Measure Gap Width

+ Measure Height Difference Point to Point

- Measure Height Differences Points to Baseline
+ Measure Height Differences Points to Plane
+ Measure Longest Line Segment

+ Measure Plane Height Differences Along Direction Parallel To Axes

« Measure Result
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+ Merge Point Cloud Lists

+ Merge Data

* Merge Depth Maps

+ Merge Label List

+ Merge LineSegment Lists

+ Merge Point Clouds with Similar Heights

+ Merge Point Clouds

+ Merge Pose Lists

+ Merge Mask Images

+ Morphological Transformations

+ Move Point Cloud along Specified Direction
- Move Poses to Point Cloud Surfaces along Z-Axis
+ Normal Estimation

* Notify

+ Number Scaling

+ Numeric Operation

+ OCR

- Offset Poses in Cylinder

+ Orthographic Projection Inverse

+ Orthographic Projection

+ Pack

+ pallet-information-recognition.pdf

+ Path Planning

+ Periodic Trigger

- Perspective Transformation

- picking-relaxation.pdf

+ Plan Object Poses at Placement

+ Point Axes of Poses to Given Direction

+ Point Cloud Clustering

+ Point Cloud Filter

+ Point Cloud Shape Detector

- Point Filter

- Adjust Poses

» Pose Filter

- Rotate Poses by Quaternion Vectors in Object Frames
+ Transform Poses by Matrix in Object Frames

+ Check Pose Repeatability by Statistics

© 2024 Mech-Mind Robotics Technologies Ltd. 110


pallet-information-recognition.pdf
picking-relaxation.pdf

i o/

MECH MIND Vision System Software Manual

» Predict Object Poses (Sim2Pick)

» Predict Pick Points (Any Object)

+ Predict Pick Points V2

» Procedure Out

* Procedure

+ Process 2D Shapes

+ Project Points onto Plane

» Project 3D Point Cloud to 2D Image

* Read Bar Code

* Read Images V2

+ Read Images

+ Read Object Dimensions

* Read Point Cloud V2

* Read Point Cloud

+ Read Poses from File

* Read QR Code

* Read STL

- Read 3D ROI Center

+ Record Criterion Pose and Calc Transformation
+ Recover Scaled Images in 2D RO

+ Rectify Image by Frame Transformation
+ Rectify Ring Object Poses

+ Remove All Overlapping Poses

» Remove Cloud Points from Point Cloud
+ Remove Noise in Masks

+ Remove Overlapped Objects V2

+ Remove Overlapped Objects

+ Remove Overlapped Polygons

+ Remove Cloud Points from Point Cloud
+ Remove Polygons outside Mask

+ Reorder According to Given Indices

+ Reorder by Index List

+ Repeat Data and Concatenate Copies

+ Replace Elements in List

*+ Reverse List

- Rotate Axis to Minimize Included Angle to Reference Direction

+ Rotate Images by Specified Poses
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- Rotate Poses around Axis by Angle

* Rotate Poses around Given Axis

* Rotate Poses Locally

- Rotate Poses to Directions Freely

- Rotate Poses’ Axes to Specified Directions under Symmetry Constraints
- Rotate Poses’ Axes to Specified Directions
+ Save Images

+ Save Regions around Poses as 3D ROIs
+ Save Result to XML File

+ Save Results to File

+ Save Path Targets

+ Save Step Parameters to File

+ Scale Image in 2D ROI

+ Segment Depth Map

+ Send Point Cloud to External Service

+ Set Pose Quaternions

+ Set Pose Translation

+ Show Images

» Show Point Clouds and Poses

+ Smooth Depth Map

» Smooth Path

« Sort List and Output Index List

+ Sort and Stratify

» Sort Point Clouds

+ Sort Poses by Input Scores

+ Sort Poses by XYZ Values

+ Sort 2D Poses

» Sort 3D Poses

« Straighten Ring Shaped Image Region

+ Stratify Values by Thresholds

+ Subtract Real Numbers

- Suppress Neighboring Poses with Low Scores (NMS)
+ symmetry-type.pdf

+ Template Matching

+ Test

- Path Target Matching

« Transform Image
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+ Align Plane Point Clouds

» Transform Point Clouds for Truss

» Transform Point Clouds

+ Transform Poses for Truss

« Transform Poses

+ Translate Poses along Customized Direction by Distances
+ Translate Poses along Given Direction

« Translate Poses by Direction and Distance

« Translate Poses by Vector3D

+ Translate Poses Locally by Distances

+ Trigger Control by Flag

« Trigger

« Trim Input List

* Trim Pose List

+ Unpack and Merge Data

+ Unpack Data

- Validate 2D Poses by Mask

- validate-and-calc-parameter-compensation.pdf
+ Validate Box Dimensions

- Validate Box Object Masks

+ Validate Existence of Poses in 3D ROI

- Validate Labels and Output Flags

- Validate Masks Containing 2D Poses

+ Validate Point Clouds

+ Validate Poses by Included Angles to Reference Direction
+ Validate Underlying Poses

+ Extract Regions of Large Normal Deviations

+ Vector3D Arithmetic Operations

« Verify Pick Points

+ Visualize Depth in Range

» Visualize Information on Image

Common Procedures

Mech-Vision software stores the commonly used Procedures in the Custom directory in the Step
library. Please check the contents below to learn about the detailed introduction to Procedures.

+ Large Workpiece Measurement
» Sort
-+ 3D Matching
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+ Apply Masks to Color Image

+ Calc Color Image for Highest Layer

» Filter Out Point Clouds That Exceed The Limit
« Filter Out Poses Out Of ROI

» Point Cloud Preprocessing

+ Save Images and Step Parameters

4.3.1. Convert Poses 2D to 3D According to Orthographic Projection

Contents of this Step are under maintenance. If you need more information about this Step
with urgency, please contact us at docs@mech-mind.net.

Function

This Step converts 2D poses generated based on the Orthographic Projection Step to 3D poses.

Usage Scenario

This Step is generally used for measurement and follows the Orthographic Projection Step. It
converts the poses in the 2D image output from Orthographic Projection into 3D poses.

Input and Output

* Input:
1. 2D poses generated based on Orthographic Projection
3D poses converted from 2D poses
The minimum X, Y, and Z of all 3D coordinates in the point cloud
Scale of Orthographic Projection

Border width of masks generated based on Orthographic Projection

o o M~ 0 DN

Depth map corresponding to objects in the mask generated based on Orthographic
Projection

+ Output:
1. Convert 2D Poses to 3D.

4.3.2. 2D Shape Matching

Contents of this Step are under maintenance. If you need more information about this Step
with urgency, please contact us at docs@mech-mind.net.

Function

This Step uses 2D shape matching methods to locate objects in images.

Usage Scenario

This Step is a general 2D shape matching Step. This Step has no fixed usage scenarios.
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Input and Output

* Input:
1. Scene image in which objects will be matched against templates
2. Object templates

+ Output:
1. Match result masks

2. Scores corresponding to the matching results

4.3.3. 3D Coarse Matching (Multiple Models)

Function

Use multiple models to roughly match objects in the scene, and output the coarsely calculated
candidate poses of the target objects.

Usage Scenario

This Step calculates the original poses of objects in the scene by using multiple models. It is an
extensive version of the 3D Coarse Matching Step and their parameter tuning methods are similar.

This Step should be used in multi-model scenarios to distinguish workpieces of different types.
This Step is usually followed by 3D Fine Matching (Multiple Models) to obtain accurate poses.

Input and Output

&

¢ List of point clouds with
normals

<Cloud(XY¥Z-Normal) ] >
Point Clouds with Normals

3D Coarse Matching (Multiple Mo

Visualized output

<Poselists [] > <Numberlist[]] > = <Cloud(XYZ-RGB} [] ->
Initial Poses Matching Scores Visualization Point Cloud

L

List of matching scores of the
corresponding object poses

L 2

Coarsely calculated candidate
poses
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Parameter Description
Model Settings
The path of model file and pick point file.

Model File (Required)
Default value: model.ply

Instruction: The path of 3D model file, the construction process can refer to the complete point
cloud model stitching document. You can enter multiple file paths. Please use semicolons to
divide different file paths.

Geo Center Point File (Required)

Instruction: The geometric center file in JSON format. You can enter multiple file paths. Please
use semicolons to divide different file paths.

Example: Ensure that the files entered under each parameter are in the same order, meaning
that the Model File has the same path order as the Geometric Center File, as shown in the

“.n

figure below. Different files are separated by *".

Property

Step Name 3 rse Matching (Multiple Templates)_1

Execution Flags Continue When No Output

Model and Pick Point
Model File (Required) maodell.ply;model2.ply;model3.ply
Geometric Center File (Required)

Cloud Qrientation Calculation
Point ( Calc Mode Origin ¥

Number rching Points 10
Cloud Orientation Calculation

Point Orientation Calc Mode
Default setting: Origin

List of options Description

Origin Use the original normal of the input point cloud
directly.

StandardMode Use the CPU to recalculate the normal direction

of the input point cloud, which is recommended
when the model does not have the normal
direction. The k points nearest to the target
were searched, and principal component
analysis (PCA) is used to obtain the minimum
feature vector as the normal direction of the
point.

EdgeTangent The tangent direction of the input edge point
cloud is calculated as the normal direction.
Objects whose outer contours are mirror
images of each other can be distinguished. It is
recommended to match edge point clouds of
flat objects.
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List of options Description
EdgeNormal Calculate the normal direction of the input edge

point cloud, and use the tangential direction of
the point as the normal direction, which is
recommended for matching the edge point
cloud of a flat object.

When using the EdgeTangent or EdgeNormal methods, ensure that each edge point cloud
does not contain multiple objects; in other words, each object point cloud is separated.

Number of Searching Points
Default value: 10

Instruction: This parameter is used to adjust the number of adjacent points in the direction of
the computed point, which is the value of K in StandardMode mode.

Processor Type

Default value: SurfaceMatchingEasyMode

List of Values: SurfaceMatchingEasyMode, SurfaceMatching

Instruction: The algorithm is categorized into two modes based on the ease of use. Both modes
include the Result Visualization parameter group. As shown in the figure below, the front-side
model and the back-side model will be used for the matching. Parameters in

SurfaceMatchingEasyMode will be introduced first.

SurfaceMatchingEasyMode algorithm: The adjustable parameters module is Speed Controller and
Output Settings.

SurfaceMatching algorithm: The adjustable parameters module is Sample Settings, Voting
Settings, and Pose Verification Settings.
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SurfaceMatchingEasyMode
Speed Control

Main Speed Controller
Default value: 2

Instruction: This parameter is used to adjust the algorithm speed. When the value is increased,
the algorithm speed becomes faster, but the matching accuracy decreases. Its effect is more
obvious than Secondary Speed Controller. The valid range of this parameter is 1-6.

Example of adjustment: as shown in the figure below. The left figure shows the result when this
value is 2, and the right figure shows the result when this value is 6. It is obvious that the
matching accuracy decreases after adjustment.

Secondary Speed Controller
Default value: 10

Instruction: This parameter is used to adjust the algorithm speed. When the value is increased,
the algorithm speed becomes faster, but the matching accuracy decreases. Its effect is weaker
than Main Speed Controller. The valid range of this parameter is 1-20.

Example of adjustment: as shown in the figure below. The figure on the left shows the result
when this value is 10, and the figure on the right shows the result when this Value is 15. It can
be seen that the matching accuracy decreases after adjustment, but the influence is less than
that of the main speed control parameters.
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Output Settings

Maximum Number of Detected Poses in Each Point Cloud
Default value: 3

Instruction: This parameter is used to estimate the number of matching outputs per point
cloud. The larger the value, the more matches are generated.

Example of adjustment: as shown in the figure below. The left picture shows the result when
the parameter is 1, and the right picture shows the result when the parameter is 3.

SurfaceMatching
Sample Settings

Enable Automatic Downsampling
Default value: Selected

Instruction: This parameter is used to determine whether to use automatic downsampling. If it
is selected, the sampling interval parameter of point cloud template will be automatically
adjusted according to the expected points of the model after sampling.

Expected Point Number of Sampled Model
Default value: 1000
Instruction: This parameter is used to adjust the number of points of the sampling point cloud.
It is effective when Enable Automatic Downsampling is selected, and the number of points of
the point cloud is close to this value. The smaller this value is, the fewer points of sampling
point cloud are, resulting in the lower accuracy of pose estimation.

Max Point Number of Sampled Model
Default value: 4000

Instruction: This parameter is used to set the maximum number of points in the point cloud
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model after downsampling. It sets an upper limit for the number of points in our point cloud
model after downsampling. If the matching effect or matching speed is not ideal, this
parameter is recommended to be increased.

Max Point Number of Sampled Scene
Default value: 3000

Instruction: This parameter is used to set the maximum number of points in the point cloud
after the field point cloud downsampling. It sets an upper limit for the number of points in the
field point cloud after the field point cloud downsampling. If the matching effect or matching
speed is not ideal, this parameter is recommended to be increased.

Sampling Interval
Default value: 70.000 mm

Instruction: This parameter is used to adjust the maximum distance between points in the
sampling point cloud. The unit is millimeters. When the sampling interval of point cloud model
is smaller than the minimum sampling interval, the minimum sampling interval is used as the
actual sampling interval. The larger the value is, the less point clouds are used for calculation
after sampling, the lower the matching accuracy and the lower the algorithm execution time.

Example of adjustment: as shown in the figure below. The left picture shows the result when
the parameter is 0.01, and the right picture shows the result when the parameter is 0.02.

Min Sampling Interval
Default value: 3.000 mm

Instruction: This parameter is used to calculate the sampling interval. The unit is millimeters. It
is effective when the value of Enable Automatic Downsampling is selected. If the calculated
sampling interval is smaller than this value, this value will be used as the actual sampling
interval.

Voting Settings

Distance Quantification
Default value: 1
Instruction: The value for the quantification of the distance between points. As Distance
between Two Points = Distance Quantification x Sampling Interval, the larger the value is, the
larger the distance, and the less precise the result tends to be.

Angle Quantification
Default value: 60

Instruction: The value for the quantification of the angle between two vectors. As Angle
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between Two Vectors = 2 x 3.14 / Angle Quantification, increasing the parameter’s value will
reduce the matching accuracy.

Max Vote Ratio
Default value: 0.8

Instruction: This parameter sets the threshold for the proportion of the number of votes to the
maximum number of votes. The number of votes corresponding to each pose will be obtained
in the previous steps, and the maximum number of votes multiplied by this parameter will get a
threshold. When the number of votes of a pose is greater than this threshold, the corresponding
pose will be retained for clustering operation. The smaller the value, the more likely it is to find
an accurate match, but the running time increases. The valid range of this parameter is 0-1.

Reference Point Step
Default value: 5

Instruction: This parameter is used to adjust the selection step of the reference point. The step
size is taken as an interval sampling point from the point cloud. When the value is larger, the
interval sampling points are fewer, and the execution speed is faster, but the matching
accuracy is reduced.

Referred Point Step
Default value: 1

Instruction: This parameter is used to adjust the selection step of the referred point. The step
size is taken as an interval sampling point from the point cloud. When the value is larger, the
interval sampling points are fewer, and the execution speed is faster, but the matching
accuracy is reduced.

- Areference point and a referred point make up a point pair. The larger the sampling step,
the fewer referring points and referred points after downsampling, the fewer the point pairs,
and the faster the execution.

+ Reference point is the sampling point on the matching model. Referred point is the
sampling point not on the matching model.

Clustering Settings

Cluster Ratio
Default value: 0.1

Instruction: This parameter is used to adjust the proportion of the number of poses used for
clustering to the total computed poses. Any pose will be given a score during the calculation,
and all poses will be sorted according to the score. This parameter determines how much of
the pose is used for clustering, A value of 0.1 means that the top 10% pose is taken as the pose
for clustering. The larger the value, the more likely it is to find an accurate match, but the
running time increases accordingly.

Threshold of Angle Difference
Default value: 15

Instruction: This parameter is used to adjust the size of the Angle increment in the clustering
process. In the final calculation result, the same object may calculate multiple poses, which
determines the increment of the Angle parameter when the poses with very close parameters
are fused. The larger the parameter is, the pose with large Angle difference will be fused into
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the final result, and the matching accuracy will decrease.

Threshold of Distance Difference
Default value:; 0.02

Instruction: This parameter is used to adjust the size of the Distance increment in the clustering
process. In the final calculation result, the same object may calculate multiple poses, which
determines the increment of the Distance parameter when the poses with very close
parameters are fused. The larger the parameter is, the pose with large Angle difference will be
fused into the final result, and the matching accuracy will decrease.

Output First N Clusters with High Scores
Default value: 5

Instruction: This parameter is used to take the top N results with the highest score from the
multiple matching results obtained after clustering adjustment as the final result.

Pose Verification Settings

Use Pose Verification
Default value: Selected

Instruction: This parameter determines whether pose validation is used. When the parameter is
selected, all cluster parameters are invalid. Pose validation and clustering are two different
methods for verification and screening of final matching results, which cannot be used
simultaneously.

Marked Margin
Default value: 1

Instruction: This parameter is used to control the size of the verification area during pose
verification. A single voxel is a unit. When the value is increased, the mark area used to verify
the pose becomes larger, and more points are included to verify the final result, thus reducing
the matching accuracy.

Voxel Length
Default value: 3

Instruction: The space where the point cloud is located is divided into a 3D grid, and the
parameter is the size of the smallest unit of the 3D grid. When the value is increased, the box
selection range becomes larger and there are more selected points for pose verification. In this
case, the algorithm speed becomes faster, but the matching accuracy decreases.

Maximum Number of Detected Poses in Each Point Cloud
Default value: 3

Instruction: For SurfaceMatching algorithm, this parameter has the same effect as for
SurfaceMatchingEasyMode algorithm. Only results are compared here.

Example of adjustment: The left side of figure below is the result when the parameter value is 3,
and the right side is the result when the parameter value is 1.
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Results Visualization

Show Sampled Model Cloud
Default value: Unselected

Instruction: This parameter is used to display the downsampled point cloud model.

Show Sampled Scene Cloud
Default value: Unselected

Instruction: This parameter is used to display the downsampled field point cloud.

Show Matching Results
Default value: Selected

Instruction: This parameter is used to display the matched model and field point cloud.

4.3.4. 3D Coarse Matching V2

Function

This Step coarsely matches the point cloud model with the original point clouds and outputs the
coarsely calculated candidate poses of the target objects.

Usage Scenario

This Step is usually used to detect the target object in the scene point cloud and obtain
approximate candidate pose. This Step is usually followed by the 3D Fine Matching Step.

Input and Output
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¢ Point clouds with normals
containing objects to match

<Cloud({XYZ-Normal) [] >
Point Clouds with Normals

3D Coarse Matching V2 (1)

Visualized Output

<PoseList[]-> <NumberList[] ->
Coarsely Calculated Peses = Matching Scores

—— & Pose matching scores

178
183
185

& Coarsely calculated candidate
poses of the objects

posel
pose2
pose3
Parameters
Parameter Tuning Level
Parameter description: This parameter is used to select the Parameter Tuning Level for the Step.

Value list: Basic and Advanced.

Default value: Basic.

Basic Parameter Tuning Level

Model Settings

Model Selection

Parameter description: This parameter is used to select the point cloud model file in the model
library (project folder/resource/3d_matching).

Tuning instruction: After making a point cloud model with the Matching Model and Pick Point

Editor, click the button to the right of the parameter to expand the drop-down list to select or
switch the point cloud model file.
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Matching Method

Parameter description: This parameter is used to select the matching mode for 3D coarse
matching.

Value list: Edge matching and Surface matching.
Default value: Edge matching.
Tuning instruction: Please select the mode according to the point cloud model in use. If the

point cloud model represents the edge of the workpiece, select Edge matching; if the point
cloud model represents the surface of the workpiece, select Surface matching.

Preprocessing Settings

Expected Point Count of Sampled Model

Parameter description: This parameter is used to set the expected number of points in the point
cloud model after downsampling. The lower this value is, the fewer points there are in the
downsampled point cloud, and the lower the matching accuracy is.

Default value: 200

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Point Count Upper Threshold of Sampled Input Point Cloud

Parameter description: This parameter is used to set the maximum number of points in the
scene point cloud after downsampling. If the number of points in the scene point cloud after
downsampling exceeds this value, the scene point cloud will be ignored, and empty data will be
output.

Default value: 700000

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Pose Verification Settings

Expected Number of Detected Poses per Input Point Cloud

Parameter description: This parameter is used to set the expected number of matched poses
for each input point cloud.

Default value: 3

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Advanced Parameter Tuning Level

Model Settings

Model Selection

Parameter description: This parameter is used to select the point cloud model file in the model
library (project folder/resource/3d_matching).

Tuning instruction: After making a point cloud model with the Matching Model and Pick Point
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Editor, click the button to the right of the parameter to expand the drop-down list to select or
switch the point cloud model file.

Model File
Parameter description: This parameter is used to select the point cloud model file.

Tuning instruction: Click [ to select a point cloud model file in PLY format.

Geo Center Point File
Parameter description: This parameter is used to select the geometric center file.

Instructions: Click [ to select a geometric center file in JSON format.
Matching Method

Parameter description: This parameter is used to select the matching mode for 3D coarse
matching.

Value list: Edge matching and Surface matching.

Default value: Edge matching.

Tuning instruction: Please select the mode according to the point cloud model in use. If the point
cloud model represents the edge of the workpiece, select Edge matching; if the point cloud model
represents the surface of the workpiece, select Surface matching.

Preprocessing Settings

Expected Point Count of Sampled Model

Parameter description: This parameter is used to set the expected number of points in the point
cloud model after downsampling. The lower this value is, the fewer points there are in the
downsampled point cloud, and the lower the matching accuracy is.

Value range: 20—3000
Default value: 200

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Point Count Upper Threshold of Sampled Input Point Cloud

Parameter description: This parameter is used to set the maximum number of points in the
scene point cloud after downsampling. If the number of points in the scene point cloud after
downsampling exceeds this value, the scene point cloud will be ignored, and empty data will be
output.

Value range: 100—100000
Default value: 700000

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Number of Neighboring Points
Parameter description: This parameter is used to set the number of neighboring points for
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calculating the orientation of each point. This parameter is only available in the Edge matching
mode.

Value range: 1-100
Default value: 30
Voting Settings

Upper Limit of Point Pair Count per Feature

Parameter description: This parameter specifies the upper limit of the number of point pairs
contained in each feature during the model analysis. The lower this value is, the faster the
execution will be, but the accuracy is also lower.

Default value: 50

Distance Quantification

Parameter description: This parameter is used to quantify the distance between points in the
object point cloud. Distancelnterval = DistanceQuantification x SamplingInterval. The greater
this value is, the less accurate the matching result tends to be.

Default value: 1.0000

Angle Quantification

Parameter description: This parameter is used to quantify the angle between the normals of the
points in the object point cloud. Anglelnterval = 360°/AngleQuantification. The greater this value
is, the smaller the angle interval will be, and therefore the higher the accuracy of the matching
result is, but a point cloud of higher quality is required.

Default value: 60

Vote Ratio Lower Threshold

Parameter description: Poses with scores higher than the HighestScoretheVote x
VoteRatioLowerThreshold will go through pose verification. The lower this value is, the more
poses are used for pose verification, and therefore the more likely an exact match will be found,
but the Step will also take longer to execute.

Default value: 0.80

Referring Point Sampling Step

Parameter description: This parameter is used to adjust the step size to downsample the
referring point. The step size is taken as an interval sampling point from the point cloud. When
the value is larger, the interval sampling points are fewer, and the execution speed is faster, but
the matching accuracy is reduced.

Default value: 5

Referred Point Sampling Step

Instruction: This parameter is used to adjust the step size to downsample the referred point.
The step size is taken as an interval sampling point from the point cloud. When the value is
larger, the interval sampling points are fewer, and the execution speed is faster, but the
matching accuracy is reduced.

Default value: 1
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+ Referring point is the sampling point on the point cloud model.

+ Referred point is the sampling point not on the point cloud model.

o A referring point and a referred point make up a point pair. The larger the sampling step is, the
fewer referring points and referred points there are after downsampling, the fewer the number
of point pairs is, and the faster the execution is.

Pose Filtering Settings

Use Distance NMS

Parameter description: After this feature is enabled, candidate poses whose distances to the
selected poses are less than 0.1 times the diameter of the object will be filtered out.

Default value: Enabled.
Tuning instruction: Please refer to the tuning example for the application result.

Filter Poses by Model Rotation Angle
Instruction: In the Edge Matching mode, the point cloud model may need to be rotated by a
certain angle to match with the scene point cloud, and the posed will be filtered by the point
cloud model's rotation angle. When the model’s rotation angle exceeds the Angle Difference
Upper Threshold, the pose will be filtered out.
Default value: Enabled.

Angle Difference Upper Threshold
Instruction: See the tooltip of Filter Pose by Model Rotation Angle.

Default value: 135.000°
Pose Verification Settings

Expected Number of Detected Poses per Input Point Cloud

Parameter description: This parameter is used to set the expected number of matched poses
for each input point cloud.

Default value: 3

Tuning recommendation: Set the value according to the actual requirement. Please refer to the
tuning example for the application result.

Voxel Length Generation Strategy

Parameter description: This parameter is used to select the strategy to generate the voxel
length.

Value list: Auto and Manual.
Default value: Auto

Tuning recommendation: Auto is recommended for new users. If Manual is selected, you will
need to set the Voxel Length.

Voxel Length Lower Limit

Parameter description: This parameter is used to set the minimum voxel length in millimeters.
Default value: 1.000 mm
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Voxel Length Upper Limit

Parameter description: This parameter is used to set the maximum voxel length in millimeters.
Default value: 15.000 mm

If you divide the space occupied by the point cloud into a 3D grid, each minimum cube in this
grid is a voxel. Voxel length is the length of the cube edge.

Result Visualization

Visualization Options
Parameter description: This parameter is used to select the item that you want to visualize.

Value list: Sampled Model, Sampled Scene, Registration Result, and Points Used in Pose
Verification.

Default value: Registration Result.

Tuning instruction: Set the value according to the actual requirement. Please refer to the tuning
example for the application result.

Tuning Examples
Examples in the Basic Parameter Tuning Level

Expected Point Count of Sampled Model

In the case of a connecting rod picking project, when the Expected Point Count of Sampled Model
is set to 300 and 600, the corresponding point cloud models after downsampling are shown in the
left and right figures below, respectively.

As you can see in the figures, the points in the left point cloud are sparse while the points in the
right point cloud are dense.

Point count: 276

Point Count Upper Threshold of Sampled Input Point Cloud

When the number of points in the input point cloud exceeds the set value, a message as shown
below will appear.
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3D Coarse Matching V2 (1)

Expected Number of Detected Poses per Input Point Cloud

When the Expected Number of Detected Poses per Input Point Cloud is set to 6 and 12, the
numbers of pose results output by this Step are shown in the left and right figures below,

respectively.

There are 6 pose results in the left figure while there are 12 pose results in the right figure.

Examples in the Advanced Parameter Tuning Level

Use Distance NMS

As shown in the figure below, after this feature is enabled, candidate poses whose distances to the
selected poses are less than 0.1 times the diameter of the object will be filtered out.
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Result Visualization

Visualization Options Example

Sampled Model

Sampled Scene

Registration Result
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Visualization Options Example

Points Used in Pose Verification

4.3.5. 3D Coarse Matching

Function

Roughly match the model point cloud with the original point cloud and output approximate
candidate poses of the target candidates.

Refer to Generate Point Cloud Model for the creation of a point cloud template. )

Usage Scenario

This Step is usually used to detect the target object in the scene point cloud and obtain
approximate candidate poses. This Step is usually connected to the 3D Fine Matching Step.

Input and Output
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Parameters

Model Settings

Model Selection

Instructions: Click the drop-down button to select and apply a point cloud template and its
corresponding geometric centers.

Model file

Instructions: Click [ to select a point cloud template file in PLY format. You can use Matching
Model and Pick Point Editor to easily generate, edit, and save point cloud templates and the
corresponding geometric centers/pick points.

Geo Center Point File

Instructions: Click [ to select a geometric center file in JSON format. You can use Matching
Model and Pick Point Editor to easily generate, edit and save point cloud templates and the
corresponding geometric centers/pick points.

Cloud Orientation Calculation

Point Orientation Calc Mode
Default setting: Origin

List of options Description

Origin Use the original normal of the input point cloud
directly.

StandardMode Use the CPU to recalculate the normal direction

of the input point cloud, which is recommended
when the model does not have the normal
direction. The k points nearest to the target
were searched, and PCA (principal component
analysis) is used to obtain the minimum feature
vector as the normal direction of the point.
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EdgeTangent The tangent direction of the input edge point
cloud is calculated as the normal direction.
Objects whose outer contours are mirror
images of each other can be distinguished. It is
recommended to match edge point clouds of
flat objects.

EdgeNormal Calculate the normal direction of the input edge
point cloud, and use the tangential direction of
the point as the normal direction, which is
recommended for matching the edge point
cloud of a flat object.

Number of Searching Points
Default value: 10

Instruction: This parameter is used to set the number of adjacent points in the normal direction
of the point, which is the value of K in StandardMode mode.

Processor Type

Default value: SurfaceMatchingEasyMode

List of Values: SurfaceMatchingEasyMode, SurfaceMatching

Instruction: There are two types of this algorithm. The algorithm type parameters are adjusted
using the figure below as an example, starting with the adjustable parameters in the

SurfaceMatchingEasyMode algorithm.

SurfaceMatchingEasyMode algorithm: The adjustable parameters module is Speed Controller and
Output Settings.

SurfaceMatching algorithm: The adjustable parameters module is Sample Settings, Voting
Settings, and Pose Verification Settings.

.1
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]
|
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SurfaceMatchingEasyMode

Speed Control
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Main Speed Controller
Default value: 2

Instruction: This parameter is used to adjust the algorithm speed. When the value is increased,
the algorithm speed becomes faster, but the matching accuracy decreases. Its effect is more
obvious than Secondary Speed Controller. The valid range of this parameter is 1-6.

Example: As shown in the figure below. The left figure shows the result when this value is 2,

and the right figure shows the result when this value is 6. It is obvious that the matching
accuracy decreases after adjustment.

T

|
I
|
)
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Secondary Speed Controller
Default value: 10

Instruction: This parameter is used to adjust the algorithm speed. When the value is increased,
the algorithm speed becomes faster, but the matching accuracy decreases. Its effect is weaker
than Main Speed Controller. The valid range of this parameter is 1-20.

Example: As shown in the figure below. The figure on the left shows the result when this value
is 10, and the figure on the right shows the result when this value is 18. It can be seen that the
matching accuracy decreases after adjustment, but the influence is less than that of the main
speed control parameters.

Output Settings

Maximum Number of Detected Poses in Each Point Cloud
Default value: 3

Instruction: This parameter is used to estimate the number of matching outputs per point
cloud. The larger the value, the more matches are generated. The valid range of this parameter
is from 1 to co.

Example of adjustment: As shown in the figure below. The left picture shows the result when
the parameter is 1, and the right picture shows the result when the parameter is 3.
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SurfaceMatching
Sample Settings

Enable Automatic Downsampling
Default value: Selected

Instruction: This parameter is used to determine whether to use automatic downsampling. If it
is selected, the sampling interval parameter of point cloud template will be automatically
adjusted according to the expected points of the model after sampling.

Expected Point Number of Sampled Model
Default value: 1000

Instruction: This parameter is used to adjust the number of points of the sampling point cloud.
It is effective when the value of Enable Automatic Downsampling is selected, and the number
of points of the point cloud is close to this value. The smaller this value is, the fewer points of
sampling point cloud are, resulting in the lower accuracy of pose estimation.

Max Point Number of Sampled Model
Default value: 4000

Instruction: This parameter is used to set the maximum number of points in the point cloud
model after downsampling. It sets an upper limit for the number of points in our point cloud
model after downsampling. If the mat